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01 - Configure Microsoft Dataverse

QUESTION 1
HOTSPOT
The owner of a company needs to know who signs into the system.
You need to ensure that the owner can view the user audit logs.
Where does each action need to be performed? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/audit-data-user-activity

QUESTION 2
Your organization does not permit the use of custom code for solutions.
You need to create a view that can be viewed by all users in an organization.
Where should you create the view?

A. List view of the entity

B. Microsoft Visual Studio

C. Templates area

D. Maker portal

Correct Answer: D
Section:
Explanation:

QUESTION 3
You create a Power Apps portal to provide training and documentation for students. Students create a profile on the portal and then select and pay for courses. You plan to add free courses to the training portfolio. Free
courses must be automatically available to all students when they sign in. You need to assign default permissions to students.
What should you do?
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A. Create a Students web role and set the Authenticated Users Role option to true. Assign the web role to each registered user.

B. Create an entity for managing free courses. Create entity permission records to provide access to entity records for free courses and assign the entity permissions to users when they register on the portal for the first
time.

C. Create an entity for managing free courses. Create a Students web role and set the Authenticated Users role option to true. Create appropriate entity permissions to access the free course entity records and assign the
entity permissions to the web role.

Correct Answer: A
Section:

QUESTION 4
HOTSPOT
You create workflows to automate business processes.
You need to configure a workflow to meet the following requirements:
Be triggered when a condition is met.
Run immediately.
Perform an action when a condition is met.
You need to create a workflow that automatically sends emails based on a mail merge template. To answer, select the appropriate configuration in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:

QUESTION 5
HOTSPOT
You are a Dynamics 365 Customer Service administrator.
You need to configure the following automation for the sales team:
Send an email when the status changes on an Opportunity.
Text the sales manager when an Opportunity is created.
Create a Wunderlist task when an Opportunity is open for 30 days.
Which tool should you use for each requirement? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:
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Answer Area:
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Section:
Explanation:

QUESTION 6
A company uses Common Data Service to manage prospects. The company has a business process flow named BPFA that is associated with the Prospect entity to streamline the prospect management process. You add a field
named Category to the Prospect entity. You create additional business process flows. You apply the business process flows to Prospect records based on the selected category. Users can switch to any other newly configured
business process flows but must not use BPFA.
You need to configure the solution.
What are two possible ways to achieve this goal? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Remove all of the privileges for BPFA.

B. Use a business rule to prevent users from switching to BPFA.

C. Deactivate BPFA.

D. Change the display order of the business process flows to move BPFA to the bottom of the list.

Correct Answer: A, C
Section:

QUESTION 7
You are creating a business rule to implement new business logic.
You must apply the business logic to a canvas app that has a single screen named Screen1.
You need to configure the scope for the business rule.
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Which scope should you use?

A. Screen1

B. Entity

C. All Forms

D. Global

Correct Answer: B
Section:
Explanation:
Note: Some terminology has changed. Entity is now Table. If you're building a Canvas app, you must use table (entity) as the scope.
Reference: https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-business-rule

QUESTION 8
HOTSPOT
You are a Dynamics 365 Customer Services administrator. You have a Production instance and Sandbox instance.
Users record Production instance data in the Sandbox instance.
You need to ensure that the users only record data in the Production instance.
Which security function needs to be edited to prevent access to the Sandbox? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/control-user-access

QUESTION 9
You must create a new entity to support a new feature for an app. Records for the entity must be associated with a business unit and specify security roles for the business unit. You need to configure entity ownership.
Which entity ownership type should you use?

A. user or team owned

B. organization-owned

C. none

D. business-owned

Correct Answer: A
Section:
Explanation:
Dataverse supports two types of record ownership. Organization owned, and User or Team owned. For security purposes, records that are organization owned, the only access level choices is either the user can do the
operation or can’t. For user and team owned records, the access level choices for most privileges are tiered Organization, Business Unit, Business Unit and Child Business Unit or only the user’s own records. That means for
read privilege on contact, I could set user owned, and the user would only see their own records.
References: https://docs.microsoft.com/en-us/power-platform/admin/wp-security-cds

QUESTION 10
HOTSPOT
You need to ensure that there are no leads for a customer before you create a new opportunity for the customer.
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How can you use duplicate detection rules to achieve this goal? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:

QUESTION 11
You have two Power Platform environments.
Users in one environment must not be able to see the other environment.
You need to grant salespeople access to the sales company environment.
What should you do?

A. Add salespeople to an Office 365 security group.

B. Add salespeople to a security role.

C. Set privileges.

D. Set app security.

Correct Answer: A
Section:
Explanation:
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/control-user-access

QUESTION 12
A veterinary office plans to use Power Platform to streamline customer experiences. The customer creates a canvas apps to manage appointments.
On the client appointment form, there is a dropdown field for clients to select their type of pet. If a client selects the option Other, the veterinarian wants a text field to appear so that additional details can be added.
You need to create a dynamically visible field.
What should you configure?
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A. workflow

B. business process flow

C. business rule

Correct Answer: C
Section:
Explanation:
By combining conditions and actions, you can do any of the following with business rules:
Set column values
Clear column values
Set column requirement levels
Show or hide columns
Enable or disable columns
Validate data and show error messages
Create business recommendations based on business intelligence.
References: https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-create-business-rule

QUESTION 13
You are a Dynamics 365 Customer Service system administrator. You create an app for the sales team. Members of the sales team cannot access the app.
You need to ensure that sales team members can access the app.
Where should you configure app permissions?

A. Dynamics administration center

B. Manage Roles

C. Security Roles

Correct Answer: B
Section:
Explanation:
Manage access to apps by using security roles.
You can choose what users see and access from the My Apps page or the Customer Engagement home page by giving app access to specific security roles. Users will have access to apps based on the security roles they're
assigned to.
1. Go to Settings > My Apps.
2. In the lower-right corner of the app tile you want to manage access for, select More options (...), and then select Manage Roles. 3. Enter the following in the Manage Roles dialog box:
a) App URL Suffix
b) Roles
c) Select Save.
4. Refresh the My Apps page.
5. Go to the Apps Being Edited view, and publish the app again.
Reference:
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-apps-security-roles

QUESTION 14
You create a parent entity and a child entity. The parent entity has a 1:N relationship with the child entity. You need to ensure that when the owner changes on the parent record that all child records are assigned to the new
owner. You need to configure the relationship behavior type.
What should you use?

A. Referential

IT Certification Exams - Questions & Answers | Vdumps.com

https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-create-business-rule
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-create-business-rule
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-create-business-rule
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-create-business-rule
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-create-business-rule
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-create-business-rule
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-create-business-rule
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-create-business-rule
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-create-business-rule
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-create-business-rule
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-create-business-rule
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-create-business-rule
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-create-business-rule
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-apps-security-roles
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-apps-security-roles
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-apps-security-roles
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-apps-security-roles
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-apps-security-roles
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-apps-security-roles
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-apps-security-roles
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-apps-security-roles
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-apps-security-roles
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-apps-security-roles
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-apps-security-roles
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-apps-security-roles
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/manage-access-apps-security-roles
https://vceplus.io
https://vceplus.io
https://vceplus.io/
https://vceplus.io
https://vdumps.com


B. Referential, Restrict Delete

C. Parental

D. Restrict

Correct Answer: C
Section:
Explanation:
A parental table relationship is any 1:N table relationship where one of the cascading options in the Parental column of the following table is true.

Reference:
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/create-edit-entity-relationships

QUESTION 15
DRAG DROP
You need to recommend a role for users to perform several required tasks. The solution must use the principle of least privilege.
Which roles should you recommend? To answer, drag the appropriate roles to the correct functions. Each role may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to
view content.
NOTE: Each correct selection is worth one point.

Select and Place:
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Correct Answer:

Section:
Explanation:
Box 1: Office 365 Global Administrator
You may think that the Dynamics 365 system administrator would have power to do all the actions needed to manage Dynamics 365, but this is not the case. What's different in Microsoft cloud deployments is that licenses
and user accounts are managed in Office 365 by an Office 365 Global Administrator. This role is analogous to a network administrator for an on premises deployment. The Global Administrator is the only role to create new
user accounts and assign subscription licenses for Dynamics 365 (and other Office 365 apps such as Skype, Power BI and SharePoint).
Box 2: Dynamics 365 system administrator
The Dynamics 365 system administrator may assign roles and permissions to the Dynamics 365 user within an instance of Dynamics 365. The Dynamics 365 system administrator also controls all the settings in Dynamics 365.
Box 3: Dynamics 365 admin
The Dynamics 365 admin can perform backups and restores.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/use-service-admin-role-manage-tenant
https://community.dynamics.com/crm/b/govandthecity/posts/understanding-dynamics-365-and-office-365-admin-roles
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QUESTION 16
DRAG DROP
You are designing an app for a bank.
You must create entities for the app and configure relationships between entities:

Which relationship types should you use? To answer, drag the appropriate relationship types to the correct requirements. Each relationship type may be used once, more than once, or not at all. You may need to drag the split bar between panes
or scroll to view content.
NOTE: Each correct selection is worth one point.

Select and Place:

Correct Answer:

Section:
Explanation:
Box 1: N:1
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You add a lookup column with a many-to-one relationship.
Box 2: N:N
Box 3: N:1
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/data-platform-entity-lookup

QUESTION 17
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the stated goals. Some question sets might have more than one
correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer interactions with employees. The app uses standard table types for
customers. A user named Elisabeth Rice signs in to the app by using the following sign in name: Elisabeth.Rice@contoso.com.
After marriage, Elisabeth changes her legal name to Elisabeth Mueller.
You need to update the sign in name for the user without losing any application history.
Solution: Change Elizabeth’s username in the user record for the app.
Does the solution meet the goal?

A. Yes

B. No

Correct Answer: A
Section:
Explanation:
Change a user's email address
You must be a global admin to complete these steps.
1. In the admin center, go to the Users > Active users page.
2. Select the user's name, and then on the Account tab select Manage username.
3. In the first box, type the first part of the new email address. If you added your own domain to Microsoft 365, choose the domain for the new email alias by using the drop-down list. Learn how to add a domain. 4. Select
Save changes.
Reference:
https://docs.microsoft.com/en-us/microsoft-365/admin/add-users/change-a-user-name-and-email-address

QUESTION 18
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the stated goals. Some question sets might have more than one
correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer interactions with employees. The app uses standard table types for
customers. A user named Elisabeth Rice signs in to the app by using the following sign in name: Elisabeth.Rice@contoso.com.
After marriage, Elisabeth changes her legal name to Elisabeth Mueller.
You need to update the sign in name for the user without losing any application history.
Solution: Ask the Microsoft 365 administrator to sign in to the admin portal and change the username.
Does the solution meet the goal?

A. Yes

B. No

Correct Answer: A
Section:
Explanation:
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Change a user's email address
You must be a global admin to complete these steps.
1. In the admin center, go to the Users > Active users page.
2. Select the user's name, and then on the Account tab select Manage username.
3. In the first box, type the first part of the new email address. If you added your own domain to Microsoft 365, choose the domain for the new email alias by using the drop-down list. Learn how to add a domain.
4. Select Save changes.
Reference:
https://docs.microsoft.com/en-us/microsoft-365/admin/add-users/change-a-user-name-and-email-address

QUESTION 19
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the stated goals. Some question sets might have more than one
correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer interactions with employees. The app uses standard table types for
customers. A user named Elisabeth Rice signs in to the app by using the following sign in name: Elisabeth.Rice@contoso.com.
After marriage, Elisabeth changes her legal name to Elisabeth Mueller.
You need to update the sign in name for the user without losing any application history.
Solution: Delete the user account in the Power Platform admin portal and recreate the account by using the new name.
Does the solution meet the goal?

A. Yes

B. No

Correct Answer: B
Section:
Explanation:
Application history would be lost.
Note:
Change a user's email address
You must be a global admin to complete these steps.
1. In the admin center, go to the Users > Active users page.
2. Select the user's name, and then on the Account tab select Manage username.
3. In the first box, type the first part of the new email address. If you added your own domain to Microsoft 365, choose the domain for the new email alias by using the drop-down list. Learn how to add a domain. 4. Select
Save changes.
Reference:
https://docs.microsoft.com/en-us/microsoft-365/admin/add-users/change-a-user-name-and-email-address

QUESTION 20
HOTSPOT
You need to create a system chart for the Account entity.
The chart must display a count of accounts grouped by owner and then display the accounts by Address 1: State/Province for each owner. You begin to configure chart options as shown in the image below.
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How should you complete the configuration? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point. The chart must display a count of accounts grouped by owner, and then display the accounts by Address 1 to State/Province for each owner.

Hot Area:

IT Certification Exams - Questions & Answers | Vdumps.com

https://vceplus.io
https://vceplus.io
https://vceplus.io/
https://vceplus.io
https://vdumps.com


Answer Area:
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Section:
Explanation:

QUESTION 21
A user has access to an existing Common Data Service database.
You need to ensure that the user can create canvas apps that consume data from Common Data Service. You must not grant permissions that are not required.
Which out-of-the-box security role should you assign to the user?

A. Environment Admin

B. System Customizer

C. Common Data Service User
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D. Environment Maker

Correct Answer: D
Section:
Explanation:
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/database-security#predefined-security-roles
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/data-platform-create-app

QUESTION 22
HOTSPOT
A company deploys several model-driven apps. The company uses shared devices in their warehouse. The devices are always powered on. Users log on to the devices and then launch the apps to perform actions.
Unauthorized users recently uploaded several files after another user failed to log out of a device. The company needs to prevent these incidents from occurring in the future.
You need to configure the solution to prevent the reported security incidents.
What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:
Box 1: Set a timeout in the Power Platform admin center.
To enforce users to reauthenticate after a pre-determined period of time, admins can set a session timeout for their individual environments. Users can only remain signed in the application for the duration of session. The
application signs out the user when the session expires. Users need to sign in with their credentials to return to customer engagement apps.
Note: Configure session timeout
1. In the Power Platform admin center, select an environment.
2. Select Settings > Product > Privacy + Security.
3. Set Session Expiration and Inactivity timeout. These settings apply to all users.
Incorrect:
Configure inactivity timeout
1. In the Power Platform admin center, select an environment.
2. Select Settings > Product > Privacy + Security.
3. Set Session Expiration and Inactivity timeout. These settings apply to all users.
Box 2: Enter the restricted file types in the SharePoint admin center.
To block uploading of specific file types
1. Go to the Settings page of the new SharePoint admin center,
2. Select Sync.
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3. Select the Block upload of specific file types check box.
4. Enter the file name extensions you want to block, for example: exe or mp3.
5. Select Save.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/user-session-management
https://docs.microsoft.com/en-us/onedrive/block-file-types

QUESTION 23
HOTSPOT
A company’s sales staff wants a simplified way to manage their opportunities in Dynamics 365 Sales without adding custom code.
You need to provide a solution for each requirement.
Which solutions should you provide? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:
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Answer Area:
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Section:
Explanation:
Box 1: Add a Kanban control.
The Kanban view allows your sales team to move opportunities from one stage to another by simply dragging them.
Box 2: Add both controls to the My Opportunities view.
Kanban views help salespeople to manage their opportunities and activities effectively. Add the Kanban control to the Opportunity and Activity entity so salespeople can use the Kanban views. The Kanban control works only
on the Opportunity and Activity entities.
If you use unified interface, you can display any record in a calendar view via the calendar control. - Go to Settings->Customization->Customize the System
- Open the configuration for the entity that you want to use the calendar control (Opportunities in our example) - Click the View tab
- Click “Add Control” and select the calendar control.
- Click the dot for every interface from which you want the calendar control to be available.
Box 3: Use a List view
opportunities in Dynamics 365 Sales
Reference:
https://docs.microsoft.com/en-us/dynamics365-release-plan/2020wave1/dynamics365-sales/work-opportunities-kanban-view
https://crmtipoftheday.com/1206/view-any-dynamics-365-record-on-a-calendar/
https://fivep.com.au/how-to-get-visibility-and-report-on-an-opportunities-active-current-sales-stage-without-code-microsoft-dynamics-365/

QUESTION 24
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the stated goals. Some question sets might have more than one
correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
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You administer the Microsoft 365 and Power Platform environments for Contoso, Ltd. The company has a model-driven app that is used to track customer interactions with employees. The app uses standard table types for
customers. A user named Elisabeth Rice signs in to the app by using the following sign in name: Elisabeth.Rice@contoso.com.
After marriage, Elisabeth changes her legal name to Elisabeth Mueller.
You need to update the sign in name for the user without losing any application history.
Solution: From Dynamics 365 Settings, select Email Configuration. In the active mailbox for the user, update the name.
Does the solution meet the goal?

A. Yes

B. No

Correct Answer: B
Section:
Explanation:
Change the user name, not the email configuration.
Change a user's email address
You must be a global admin to complete these steps.
1. In the admin center, go to the Users > Active users page.
2. Select the user's name, and then on the Account tab select Manage username.
3. In the first box, type the first part of the new email address. If you added your own domain to Microsoft 365, choose the domain for the new email alias by using the drop-down list. Learn how to add a domain. 4. Select
Save changes.
Reference:
https://docs.microsoft.com/en-us/microsoft-365/admin/add-users/change-a-user-name-and-email-address

QUESTION 25
You plan to implement Microsoft Dataverse.
You must track changes for two columns in the Account table. You must maintain a historical log of changes for the two columns and track only what is necessary. You configure the appropriate organization settings.
You need to configure the system to track changes for the two columns.
Which two actions should you perform? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. Enable auditing for the Account table.

B. Enable auditing for the two specific columns.

C. Enable change tracking for the Account table.

D. Enable change tracking for the two specific columns.

Correct Answer: A, B
Section:
Explanation:
By setting the IsAuditEnabled property of a table’s definition and the IsAuditEnabled property of each desired column’s definition to true, data changes to records of those tables can be logged by the platform.
Note: There are three levels where auditing can be configured: organization, table, and column. The organization level is the highest level, followed by the table level, and finally the column level. For column auditing to take
place, auditing must be enabled at the column, table, and organization levels. For table auditing to take place, auditing must be enabled at the table and organization levels.
Reference:
https://docs.microsoft.com/en-us/powerapps/developer/data-platform/configure-entities-attributes-auditing

QUESTION 26
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the stated goals. Some question sets might have more than one
correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
On a Contact record, a user creates a Note record that contains the word running.
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One week later, the user reports that they cannot find the Contact record associated with the Note record.
You need to find the Note record.
Solution: Use Categorized Search to search for the word run.
Does the solution meet the goal?

A. Yes

B. No

Correct Answer: B
Section:
Explanation:
Instead use Relevance Search.
Note: Relevance Search finds matches to any word in the search term in any field in the entity. Matches may include inflectional words, like "stream," "streaming," or "streamed."
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search

QUESTION 27
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the stated goals. Some question sets might have more than one
correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
On a Contact record, a user creates a Note record that contains the word running.
One week later, the user reports that they cannot find the Contact record associated with the Note record.
You need to find the Note record.
Solution: Use Relevance Search to search for the word run.
Does the solution meet the goal?

A. Yes

B. No

Correct Answer: A
Section:
Explanation:
Relevance Search brings the following benefits:
Finds matches to any word in the search term in any field in the entity. Matches may include inflectional words, like "stream," "streaming," or "streamed." Includes the ability to search documents found in Notes and
Attachments on Emails and Appointments
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search

QUESTION 28
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the stated goals. Some question sets might have more than one
correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
On a Contact record, a user creates a Note record that contains the word running.
One week later, the user reports that they cannot find the Contact record associated with the Note record.
You need to find the Note record.
Solution: Use Quick Find search on the Notes list to search for the word run.
Does the solution meet the goal?

A. Yes
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B. No

Correct Answer: B
Section:
Explanation:
Instead use Relevance Search.
Note: Relevance Search finds matches to any word in the search term in any field in the entity. Matches may include inflectional words, like "stream," "streaming," or "streamed."
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search

QUESTION 29
DRAG DROP
You are implementing a model-driven app to support a new line of business.
There are several places where automated business logic must be applied.
You need to determine how to apply the business logic.
Which method should you use? To answer, drag the appropriate methods to the appropriate business logic statements. Each method may be used once, more than once, or not at all. You may need to drag the split bar
between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

Select and Place:

Correct Answer:

IT Certification Exams - Questions & Answers | Vdumps.com

https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization#what-is-relevance-search
https://vceplus.io
https://vceplus.io
https://vceplus.io/
https://vceplus.io
https://vdumps.com


Section:
Explanation:
Box 1: Business rule
By combining conditions and actions, you can do any of the following with business rules:
Set column values
Clear column values
Set column requirement levels
Show or hide columns
Enable or disable columns
Validate data and show error messages
Create business recommendations based on business intelligence.
Box 2: Real-time workflow
Real-time workflows:
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Box 3: Power Automate instant flow
Instant Flows don’t have a trigger in the same way as the Automated flow. Instead, they are triggered manually or on-demand, such as a user clicking a Flow button in the mobile app.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-business-rules-recommendations-apply-logic-form
https://docs.microsoft.com/en-us/powerapps/maker/data-platform/configure-workflow-steps
https://carldesouza.com/difference-between-instant-automated-and-scheduled-flows-in-power-automate-and-how-to-change-the-type/

QUESTION 30
Your organization does not permit the use of custom code for solutions.
You need to create a view that can be viewed by all users in an organization.
Where should you create the view?

A. Advanced Find

B. Maker portal

C. Microsoft Excel template

D. System settings

Correct Answer: A
Section:

QUESTION 31
HOTSPOT
You develop a Power Apps app.
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Users report that the main form does not display data from other entities or allow them to edit data from other entities.
You need to embed information from other entities in the form and allow users to edit the data.
Which actions should you perform? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:

Section:
Explanation:
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Box 1: Add a quick create form
With quick create forms, your app can have a streamlined data entry experience with full support for logic defined by form scripts and business rules.
Box 2: Add a quick view
A quick view form can be added to another form as a quick view control. It provides a template to view information about a related entity record within a form for another entity record. This means your app users do not
need to navigate to a different record to see the information needed to do their work.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-quick-create-forms
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/create-edit-quick-view-forms

QUESTION 32
HOTSPOT
A company uses a canvas app to manage production resources in a specific region. Employees must be at company locations to use the app.
Due to a sudden requirement for employees to work remotely, employees no longer commute to a specific location to conduct their work and cannot access the canvas app.
You must reconfigure the app to ensure that employees only access the app from a limited number of locations.
You need to restrict access to the app.
Which components should you configure? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/restrict-access-online-trusted-ip-rules

01 - Create apps by using Microsoft Power Apps

QUESTION 1
Your organization does not permit the use of custom code for solutions.
You need to create a view that can be viewed by all users in an organization.
Where should you create the view?

A. Advanced Find

B. Entities component of a solution

C. Microsoft Virtual Studio

D. Templates area

Correct Answer: B
Section:
Explanation:
Entity: Refers to a table in Dataverse. Table and entity are often used interchangeably for data access. Edit public views through tables
In the solution create a new table or find an existing table that where the public views need to be edited. Expand Data, select Tables, select the table you want, and then select the Views area.
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On the toolbar, select Add view. Add view to table
On the Create a view dialog, enter a name and, optionally, a description, and then select Create.
Reference: https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-editviews-app-designer

QUESTION 2
DRAG DROP
You are a Dynamics 365 Customer Service help desk administrator.
Cases entered in forms require different types of data to be stored in different types of fields.
You need to create forms for each of the following case types:

Which form types should you create? To answer, drag the appropriate form types to the meet the data entry requirements. Each source may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll
to view content.
NOTE: Each correct selection is worth one point.

Select and Place:

Correct Answer:
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Section:
Explanation:
Reference:
https://docs.microsoft.com/en-us/dynamics365/customer-service/create-design-forms-customer-service-hub

QUESTION 3
DRAG DROP
You are a Dynamics 365 Customer Service developer.
A salesperson creates a chart.
You need to ensure that the chart is available to all users on the team.
Which actions should the salesperson perform? To answer, drag the appropriate actions to the correct users. Each action may be used once, more than once, or not at all. You may need to drag the split bar between panes or
scroll to view content.
NOTE: Each correct selection is worth one point.

Select and Place:
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Correct Answer:

Section:
Explanation:

QUESTION 4
HOTSPOT
You implement an editable grid for the Account entity.
The business team provides the following list of features that they would like you to implement:
Group by or sort columns in the current view.
Configure a business rule to show an error message.
Edit values in calculated fields.
Edit the Address composite field.
Use the editable grid on mobile phones.
Which actions can you perform? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.
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Hot Area:

Answer Area:
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Section:
Explanation:
Reference:
https://docs.microsoft.com/en-us/dynamics365/customerengagement/on-premises/customize/make-grids-lists-editable-custom-control

QUESTION 5
DRAG DROP
You must create a form for team members to use. The form must provide the ability to:
Lock a field on a form.
Trigger business logic based on a field value.
Use existing business information to enhance data entry.
You need to implement business rule components to create the form.
Which components should you use? To answer, drag the appropriate components to the correct requirements. Each component may be used once, more than once, or not at all. You may need to drag the split bar between
panes or scroll to view content.
NOTE: Each correct selection is worth one point.

Select and Place:
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Correct Answer:

Section:
Explanation:

QUESTION 6
You have a form that displays a custom field from an entity.
A customer wants to restrict users from filtering on the custom field.
You need to prevent users from filtering the field in Advanced Find.
What should you modify?

A. Fields in the Edit Filter Criteria option of the Quick Find view

B. a searchable field on the Field Properties form

C. Fields in the Add Find Columns option of the Quick Find view

Correct Answer: B
Section:
Explanation:
Setting Searchable property to No, makes the field disappear from the available fields for the Filter configuration, but it won’t hide the field when adding columns to the view. This property has no impact on behaviour of the
Global and Quick Find Search.
Reference:
https://community.dynamics.com/365/b/dynamics365apps/posts/kb-understanding-dynamics-365-field-s-searchable-property
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QUESTION 7
HOTSPOT
You are designing a canvas app that connects to Common Data Service.
You need to configure the app to meet the requirements and ensure that the canvas app is available offline.
What should you implement? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point

Hot Area:

Answer Area:
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Section:
Explanation:
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/offline-apps

QUESTION 8
You have a canvas app that allows users to view, select, and purchase products. The app uses a Gallery control to display products and checkboxes that allow users to select products. When users select items from the product
catalog, they move to a different screen to complete a purchase. Users must be able to clear all product selections when they click the button.
You need to configure the button.
What should you do?

A. Use the Reload(Control) formula and pass the gallery control as parameter to the Reload formula.

B. Use the Reset(control) formula and pass the checkbox to the formula to clear user selections.

C. Set the OnCheck value to populate a collection and the OnUncheck value to remove the item from the collection. Clear the collection when the user selects the button.

D. Use the Revert(Products) formula and pass the checkbox to the formula to clear user selections.

E. Use the Reset(Control) formula and pass the gallery control as a parameter to the Reset formula.

Correct Answer: B
Section:
Explanation:
The Reset function resets a control to its Default property value. Any user changes are discarded.
You cannot reset controls that are within a Gallery or Edit form control from outside those controls. You can reset controls from formulas on controls within the same gallery or form.
Reference: https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-reset
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QUESTION 9
HOTSPOT
You have a canvas app that contains the following text input fields: Id, FirstName, LastName. The app also has a button named Button1. The OnSelect property for Button1 contains the following expression:
Collect(People, {Id:Id.Text, FirstName:FirstName.Text, LastName:LastName.Text})
For each of the following statements, select Yes if the statement is true. Otherwise, select No.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:
Box 1: Yes
If the data source doesn't already exist, a collection is created.
Box 2: No
Note: The Collect function adds records to a data source. The items to be added can be:
A single value: The value is placed in the Value field of a new record. All other properties are left blank. A record: Each named property is placed in the corresponding property of a new record. All other properties are left
blank. A table: Each record of the table is added as a separate record of the data source as described above. The table isn't added as a nested table to a record. To do this, wrap the table in a record first.
Box 3: No
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/functions/function-clear-collect-clearcollect

QUESTION 10
HOTSPOT
You are a Dynamics 365 Customer Service administrator.
A user must be able to view system posts and activities in a dashboard.
You need to create the dashboard for the user.
Which components should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:
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Answer Area:

Section:
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Explanation:
Box 1: Timeline
The timeline helps agents see all customer interaction history across channels, personnel, and the support lifecycle. The timeline is used across Dynamics 365 applications to capture activities like notes, appointments, emails,
tasks, and more, to ensure that all interactions with the customer are tracked and visible over time. Agents use the timeline to quickly catch up on all of the latest activity details with the customer to provide the most
personalized support experience.
Box 2: Lists
Reference:
https://docs.microsoft.com/en-us/dynamics365/customer-service/customer-service-hub-user-guide-timeline-admin

QUESTION 11
You have a canvas app that allows users to view, select, and purchase products. The app uses a Gallery control to display products and checkboxes that allow users to select products. When users select items from the product
catalog, they move to a different screen to complete a purchase. Users must be able to clear all product selections when they click the button.
You need to configure the button.
What should you do?

A. Use the Reset(Control) formula and pass the gallery control as a parameter to the Reset formula.

B. Use the Reload(Control) formula and pass the gallery control as a parameter to the Reload formula.

C. Use the ForAll() function to iterate through each item of the Gallery and clear user selections.

D. Set the OnCheck value to populate a collection and the OnUncheck value to remove the item from the collection. Clear collection when the user selects the button.

Correct Answer: A
Section:

QUESTION 12
A customer tracks events by using a custom entity.
The custom entity includes a custom field for the venue of the events. The customer must be able to display the events by venue in a calendar. You need to ensure that all events display by venue in the calendar.
To which component should you add a control?

A. Form

B. Subgrid

C. Chart

D. View

Correct Answer: D
Section:
Explanation:
If you use unified interface, you can display any record in a calendar view via the calendar control.
1. Go to Settings->Customization->Customize the System
2. Open the configuration for the entity that you want to use the calendar control (Opportunities in our example) 3. Click the View tab
4. Click “Add Control” and select the calendar control.
5. Click the dot for every interface from which you want the calendar control to be available.
Reference:
https://crmtipoftheday.com/1206/view-any-dynamics-365-record-on-a-calendar/

QUESTION 13
You are creating a canvas app.
A user will click a button on each screen of a Power Apps app to proceed to the next screen.
You need to implement the action which selects the next screen that the user sees.
Which event should you handle?
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A. ScreenTransition

B. OnSelect

C. OnLoad

D. OnCheck

Correct Answer: B
Section:
Explanation:
Add navigation
1. With the Source screen selected, open the Insert tab, select Icons, and then select Next arrow.
2. With the arrow still selected, select the Action tab, and then select Navigate.
3. The OnSelect property for the arrow is automatically set to a Navigate function.

4. When a user selects the arrow, the Target screen fades in.
5. On the Target screen, add a Back arrow, and set its OnSelect property to this formula:
6. Navigate(Source, ScreenTransition.Fade)
7. While holding down the Alt key, toggle between screens by selecting the arrow on each screen.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables

QUESTION 14
HOTSPOT
A company has a canvas app that includes the following screens: Screen1 and Screen2.
The OnVisible property for Screen1 contains the following expression.
Set(AgeGroups, ["1-25", "26-54", "55+"])
For each of the following statements, select Yes if the statement is true. Otherwise, select No.
NOTE: Each correct selection is worth one point.

Hot Area:

IT Certification Exams - Questions & Answers | Vdumps.com

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/add-screen-context-variables
https://vceplus.io
https://vceplus.io
https://vceplus.io/
https://vceplus.io
https://vdumps.com


Answer Area:

Section:
Explanation:

QUESTION 15
You are a Dynamics 365 Customer Service developer.
A salesperson creates a chart.
You need to ensure that the chart is available to all users on the team.
What should you do?
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A. Share the chart with the team.

B. Assign the chart to each person on the team.

C. Export the user chart to Power BI. Import the chart as a Power BE visualization.

D. Export the user chart for import as a user chart.

Correct Answer: A
Section:

QUESTION 16
DRAG DROP
You are a Dynamics 365 administrator.
You create a new app.
You need to create the site map for the app.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the correct order.

Select and Place:

Correct Answer:
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Section:
Explanation:

01 - Implement Microsoft Power Virtual Agents chatbots

QUESTION 1
A company is developing several Power Virtual Agents chatbots. The company manufactures more than 1,000 different products. The chatbots must prompt users to enter or select a product.
You need to store the product information so that it can be reused across all chatbots.
Where should you store the model data?

A. Global variables

B. Custom entities

C. Topics

D. Multiple choice options

Correct Answer: A
Section:

QUESTION 2
DRAG DROP
A company creates a Power Virtual Agents chatbot.
You need to determine when live agents are engaged to provide support.
Which metrics should you use? To answer, drag the appropriate metrics to the correct processes. Each metric may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to
view content.
NOTE: Each correct selection is worth one point.

Select and Place:
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Correct Answer:

Section:
Explanation:
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/teams/analytics-summary-teams

QUESTION 3
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the stated goals. Some question sets might have more than one
correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are creating Power Virtual Agents chatbot that captures demographic information about customers.
The chatbot must determine the group a customer belongs to based on their age. The age groups are:
0 - 17
18 - 25
26 - 35
36 - 55
55 - 100
You need to configure the chatbot to ask a question that can be used to determine the correct age group.
Solution: Use Date and time for Identify in the question and then add branches that use conditional logic to determine the age group.
Does this meet the goal?

A. Yes

B. No

Correct Answer: B
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Section:

QUESTION 4
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the stated goals. Some question sets might have more than one
correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are creating Power Virtual Agents chatbot that captures demographic information about customers.
The chatbot must determine the group a customer belongs to based on their age. The age groups are:
0 - 17
18 - 25
26 - 35
36 - 55
55 - 100
You need to configure the chatbot to ask a question that can be used to determine the correct age group.
Solution: Use multiple choice for Identify in the question and create options that represent of the age groups.
Does this meet the goal?

A. Yes

B. No

Correct Answer: B
Section:

QUESTION 5
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the stated goals. Some question sets might have more than one
correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You are creating Power Virtual Agents chatbot that captures demographic information about customers.
The chatbot must determine the group a customer belongs to based on their age. The age groups are:
0 - 17
18 - 25
26 - 35
36 - 55
55 - 100
You need to configure the chatbot to ask a question that can be used to determine the correct age group.
Solution: Create a custom Age group entity and synonyms for each individual age in the corresponding item. Use Age group for Identify in the question.
Does this meet the goal?

A. Yes

B. No

Correct Answer: A
Section:

QUESTION 6
HOTSPOT
You create a new Power Virtual Agents chatbot for an organization.
Testing and production deployment of the chatbot are not complete.
You need to ensure that appropriate users can access the chatbot.
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Which methods should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:
Box 1: Use the demo website
When publishing the bot to the web, you can publish to a prebuilt demo website (which you can use to share the bot with your teammates and stakeholders) and to your own live website. Box 2: Share the chatbot to a
security group containing all users.
A license for each user, also known as a "per user license" (or "Power Virtual Agent User License" as referred to on the Microsoft 365 admin center), should be assigned to individual users who need access to create and
manage chatbots. To simplify user license management, you can assign licenses to an Azure Active Directory (Azure AD) security group.
Box 3: Embed the chatbot code in an IFRame on your copany's public website
You can add your bot to a live website as an IFrame. Your live website can be a customer-facing external website or an internal site, like a SharePoint or Yammer site.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/publication-connect-bot-to-web-channels
https://docs.microsoft.com/en-us/power-virtual-agents/requirements-licensing

QUESTION 7
DRAG DROP
You are designing a chatbot for a sports outlet.
You need to complete the chatbot.
Which features should you use? To answer, drag the appropriate features to the correct requirements. Each feature may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll
to view content.
NOTE: Each correct selection is worth one point.

Select and Place:
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Correct Answer:

Section:
Explanation:
Box 1: Entities
Out of the box, Power Virtual Agents comes with a set of prebuilt entities, which represent the most commonly used stereotype information in real-world dialogs, such as age, colors, numbers, and names.
With the knowledge granted by entities, a bot can smartly recognize the relevant information from a user input and save it for later use.
Box 2: Topics
In Power Virtual Agents, a topic defines a how a bot conversation plays out.
You can author topics by customizing provided templates, create new topics from scratch, or get suggestions from existing help sites.
A topic has trigger phrases – these are phrases, keywords, or questions that a user is likely to type that is related to a specific issue – and conversation nodes – these are what you use to define how a bot should respond and
what it should do.
Box 3: Variables
Variables let you save responses from your customers in a conversation with your bot so that you can reuse them later in the conversation.
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For example, you can save a customer's name in a variable called UserName. The bot can then address the customer by name as the conversation continues.
You can use variables to create logical expressions that dynamically route the customer down different conversation paths.
Incorrect Answers:
Flows: You can enable your bot to perform an action by calling a Microsoft Power Automate flow. Flows can help you automate activities, or call backend systems. For example, you can use flows with end-user authentication to retrieve
information about a user after they've signed in.
Flows: You can enable your bot to perform an action by calling a Microsoft Power Automate flow. Flows can help you automate activities, or call backend systems. For example, you can use flows with end-user authentication to retrieve
information about a user after they've signed in.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling
https://docs.microsoft.com/en-us/power-virtual-agents/authoring-create-edit-topics
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-flow
https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables

QUESTION 8
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the stated goals. Some question sets might have more than one
correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen. You are creating Power Virtual Agents chatbot that captures demographic
information about customers.
The chatbot must determine the group a customer belongs to based on their age. The age groups are:
0 - 17
18 - 25
26 - 35
36 - 55
55 - 100
You need to configure the chatbot to ask a question that can be used to determine the correct age group.
Solution: Use age for Identify in the question and then add branches for each group that use conditional logic.
Does the solution meet the goal?

A. Yes

B. No

Correct Answer: B
Section:
Explanation:
Instead, create a custom Age group entity and synonyms for each individual age in the corresponding item. Use Age group for Identify in the question. The prebuilt entities cover commonly used information types, but on
some occasions, such as when building a bot that serves a specific purpose, you'll need to teach the bot's language understanding model some domain-specific knowledge.
To do this, you need to create a custom entity.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

QUESTION 9
You are designing a Power Virtual Agents chatbot.
The chatbot must be able to maintain customer information if the conversation topic changes during a dialog.
You need to configure variables to store customer name and email address.
Which type of variable should you create?

A. session

B. slot

C. bot

D. topic
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Correct Answer: C
Section:
Explanation:
By default, a variable's value can only be used in the topic where this variable gets created. However, you might want the bot to use the same value across topics. This means the bot can remember the necessary context
when a conversation spans multiple topics. In some systems, these types of variables are known as global variables. In Power Virtual Agents, these variables are called bot variables, because they apply across the entire bot.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables-bot

QUESTION 10
HOTSPOT
You are designing a Power Virtual Agents chatbot for a store.
You need to teach the chatbot to acknowledge the store's product categories and the variations within specific categories.
You need to create custom entities to provide the chatbot with the knowledge of the product categories.
Which features should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:
Box 1: Smart matching
Smart match: This option is part of the intelligence supported by the bot's language understanding model. It provides the flexibility to let the bot take in user input in a fuzzy way based on the list items given to the entity.
Specifically, when this toggle is on, it lets the bot autocorrect misspellings and expands the matching logic semantically, such as automatically matching "softball" to "baseball".
Box 2: Synonyms
Synonyms: This option allows you to manually expand the matching logic by adding synonyms. Smart match and synonyms seamlessly work together to make your bot even smarter.
For example, for the "hiking" product category, you can add "trekking" and "mountaineering" as synonyms. For "Yoga", you can add "Pilates" as a synonym.
Box 3: Slot filling
Slot filling is a natural language understanding concept that means saving an extracted entity to an object. In Power Virtual Agents, slot filling means landing the extracted entity value into a variable.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

QUESTION 11
DRAG DROP
A customer has a support website that includes FAQ pages, knowledge articles, and support content.
You plan to leverage an existing Power Virtual Agents bot to enhance and streamline existing support functionality for the existing support portal.
You need to create topics from existing website content. The process must minimize human errors during topic creation.
Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the correct order.
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Select and Place:

Correct Answer:

Section:
Explanation:
You can use content from existing webpages when creating a Power Virtual Agents bot. This is useful if you already have help or support content, such as FAQ pages or support sites.
There are three main steps to using the feature:
1. Select Suggest topics on the Topics page to extract content from FAQ/support pages or online files. 2. Add the suggested topics to your bot.
3. Enable the topics.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-create-topics-from-web

QUESTION 12
You are creating a Power Virtual Agents chatbot that uses multiple topics.
Each user interaction can reference more than one topic.
You need to be able to capture a value in an initial topic and use it in subsequent topics.
Which type of variable should you create?

A. Context

B. Bot

C. Topic

Correct Answer: B
Section:
Explanation:
Reference: https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables-bot
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QUESTION 13
A company has a custom website.
You need to embed a Power Virtual Agents chatbot into the website.
What should you use?

A. Webpage URL

B. Form ID

C. Bot ID

D. Custom web channel

Correct Answer: D
Section:
Explanation:
Custom website: You can add your bot to a live website as an IFrame. Your live website can be a customer-facing external website or an internal site, like a SharePoint or Yammer site.
You can also add the bot to your Power Platform admin center.
Add bot to your website:
1. Select Manage on the side navigation pane, and then go to the Channels tab.
2. Select Custom website and then select Copy to copy it directly to the clipboard, or Share to email to open a new email message with the snippet included, in your default email app. 3. Provide the snippet to your web
developer to add the bot to your website.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/publication-connect-bot-to-web-channels

02 - Implement Microsoft Power Virtual Agents chatbots
Case Study
This is a case study. Case studies are not timed separately. You can use as much exam time as you would like to complete each case. However, there may be additional case studies and sections on this exam. You must manage
your time to ensure that you are able to complete all questions included on this exam in the time provided.
To answer the questions included in a case study, you will need to reference information that is provided in the case study. Case studies might contain exhibits and other resources that provide more information about the
scenario that is described in the case study. Each question is independent of the other questions in this case study.
At the end of this case study, a review screen will appear. This screen allows you to review your answers and to make changes before you move to the next section of the exam. After you begin a new section, you cannot
return to this section.
To start the case study
To display the first question in this case study, click the Next button. Use the buttons in the left pane to explore the content of the case study before you answer the questions. Clicking these buttons displays information such
as business requirements, existing environment, and problem statements. If the case study has an All Information tab, note that the information displayed is identical to the information displayed on the subsequent tabs.
When you are ready to answer a question, click the Question button to return to the question.
Background
Alpine Ski House is a boutique mountain resort that offers year-round spa and outdoor activities such as snow sports, hiking, mountain biking, and more. The resort has been family owned and operated for more than 50
years. The company has been able to remain profitable while not needing to adopt new technologies.
Current environment. General
Bookings at the resort have decreased. The company has decided to focus on creating a tailored, first-class experience for guests. The company also plans to target corporate meetings and events.
The company recently purchased a chatbot named FAQbot from AppSource. The chatbot uses the resort’s existing FAQs.
Current environment. Communication
Communication between staff members is primarily conducted through email and SMS text messages.
Conversations between staff members and guests are often lost.
Conference calls are used for all group meetings.
Current environment. Event registration
Corporate customers can reserve a meeting room at the resort to host meetings. The meetings will include lunch and choice of either an inside-spa experience or a seasonally appropriate outdoor activity. Event registration is
conducted three weeks prior to start of the event. It is assumed that all event attendees will attend the meeting.
Current environment. Check-in pro?ess
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Guests wait in lines to check in and obtain name badges. At this time, guests can specify any dietary restrictions and select their activity preference. This can result in long wait times and crowding at the front desk. For health
and compliance reasons, guests must answer a series of questions with a yes or no answer during check-in. The front desk will ask and record these answers for the resort’s records.
Current environment. Marketing
At the check-in counter, the guests can drop their business cards into a bowl for a chance to win an all-inclusive weekend stay at the resort. The resort uses the business card information to send announcements about
promotions and upcoming events.
Current environment. Resort policies and event inquiries
A guest can call or send an email to the event coordinator at the resort to get information about hotel policies, snow conditions, or to pre-select their after-meeting event. Guests can also go to the website to view the
extensive list of frequently asked questions (FAQ) compiled over the years. Many of the answers to the FAQ’s are out of date.
Requirements. General
Alpine Ski House does not employ technical staff and does not have the budget to hire an external firm to develop solutions. There are two team members who are proficient at Microsoft Excel formulas. Any solution created
must use the capabilities of current team members.
All solutions must be simple to use, easy to maintain, and represent the brand of the resort.
You must implement the following solutions:
a centrally managed communication solution
a customer service solution
a resort portal
a chat solution
a check-in solution
Requirements. Communication
Communication between team members must be centrally managed and unified in Microsoft Teams.
When the company confirms an event, they must provide a list of guest’s names and email addresses.
You must send guests a welcome email that includes a unique registration number for authentication with the resort’s portal. Guests must receive a separate email to verify proof of ownership for their registration.
Requirements. Event attendance
Guests must create an account and sign into a resort portal to confirm their attendance to an event and pre-select an after-meeting event. Prior to the event, guests must be able to identify any personal dietary restrictions.
Requirements. Check-in processes
Check-in processes must be self-service. Each screen must ask for specific data from the guest. The check-in solution will use some data that is stored in Microsoft Excel. The check-in solution must continue to function if there
are internet issues. If the self-service kiosks are not available, staff must be able to use the check-in solution from within their communication solution. The check-in solution must have a screen where the guest will select
either yes or no to health and wellness questions. Guests must physically interact with each answer before proceeding to the next screen. Guests must be able to confirm any dietary restrictions they may have entered from
the portal or add new ones at this time. Data must be entered in each screen before users move on to the next screen.
Requirements. Marketing
To eliminate the handling of business cards, the check-in solution must be able to translate the contents of the business cards into Alpine Ski House’s marketing system. The solution must not require any effort or manual
entry from the guest to prevent any mistyped information and to make it more appealing to the guest to participate.
Requirements. Hotel policies and event inquiries
The portal must allow the guests to ask questions about hotel policies, event information, weather reports, and current weather conditions at the resort.
Requirements. Chat solution
The chat solution must specifically address the following key words. No additional key words will be added until a later implementation phase:
Snow reports
Weather conditions
Start time
End time
Event date
Outdoor activities
Indoor activities
Most popular
The chat solution must be available always and not require staff to answer all of the questions. If a question does require a staff member’s attention, the solution must determine which staff member is best to assist the
customer with the question.
The information in the FAQ on the legacy website must be used in the chat solution but retyping all the data from the website should not be required. If guests ask about topics that are not listed in the FAQ, the chat solution
must identify the issue and escalate to a staff member.
Team members must be able to ask their own questions through a centrally managed communication solution instead of using the guest portal. Team members must be able to access the same FAQ across multiple solutions.
Issue
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Guest1 inquires about snow conditions several times during each day of their stay.

QUESTION 1
HOTSPOT
You need to design the FAQ solution to handle unknown responses.
Which component should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-hand-off

QUESTION 2
HOTSPOT
You need to embed the FAQbot into the communication solution.
Which actions should you perform? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:
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Answer Area:

Section:
Explanation:
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QUESTION 3
HOTSPOT
A guest asks about the start time of a specific scheduled event and wants to know what the snow conditions will be like during their stay.
You need to determine how to design the chat solution to answer those questions.
What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:
Box 1: Load the extracted topic into a variable
Power Virtual Agents uses entities to understand and identify a specific type of information from a user's responses. When saving the identified information to a variable, a variable type will be associated with it. The variable
type is analogous with the entity.
In Power Virtual Agents, a topic defines a how a bot conversation plays out.
A topic has trigger phrases – these are phrases, keywords, or questions that a user is likely to type that is related to a specific issue – and conversation nodes – these are what you use to define how a bot should respond and
what it should do.
Box 2: Create a custom entity
The prebuilt entities cover commonly used information types, but on some occasions, such as when building a bot that serves a specific purpose, you'll need to teach the bot's language understanding model some domain-
specific knowledge.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

QUESTION 4
You need to design the chat solution to answer the inquiry from Guest1.
Which three components can you use? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Variables

B. Escalations

C. Smart match

D. Synonyms

E. Topics

Correct Answer: A, C, D
Section:
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Explanation:
Scenario: Guest1 inquires about snow conditions several times during each day of their stay.
Variables let you save responses from your customers in a conversation with your bot so that you can reuse them later in the conversation.
Synonyms allows you to manually expand the matching logic by adding synonyms. Smart match and synonyms seamlessly work together to make your bot even smarter.
Reference:
https://docs.microsoft.com/en-us/power-virtual-agents/authoring-variables
https://docs.microsoft.com/en-us/power-virtual-agents/advanced-entities-slot-filling

QUESTION 5
You need to create the FAQ solution content.
What should you do first?

A. AI Builder

B. Automate

C. Suggest topics

D. Trigger phrases

Correct Answer: C
Section:
Explanation:
You need to make sure there are three main steps need to do while doing import FAQ and add the topic to your bot application. 1. Import Suggested Topics from FAQ webpage.
2. Add a topic.
3. Enable the topics
Reference:
https://social.technet.microsoft.com/wiki/contents/articles/53820.power-virtual-agents-faq-chatbot.aspx

03 - Implement Microsoft Power Virtual Agents chatbots
This is a case study. Case studies are not timed separately. You can use as much exam time as you would like to complete each case. However, there may be additional case studies and sections on this exam. You must manage
your time to ensure that you are able to complete all questions included on this exam in the time provided. To answer the questions included in a case study, you will need to reference information that is provided in the case
study. Case studies might contain exhibits and other resources that provide more information about the scenario that is described in the case study. Each question is independent of the other questions in this case study. At
the end of this case study, a review screen will appear. This screen allows you to review your answers and to make changes before you move to the next section of the exam. After you begin a new section, you cannot return
to this section.
To start the case study
To display the first question in this case study, click the Next button. Use the buttons in the left pane to explore the content of the case study before you answer the questions. Clicking these buttons displays information such
as business requirements, existing environment, and problem statements.
If the case study has an All Information tab, note that the information displayed is identical to the information displayed on the subsequent tabs. When you are ready to answer a question, click the
Qbutton to return to the question.
Background
ADatum Corporation provides verification and investigation services that are used by insurance companies, law firms, and other organizations in the public sector. Services include verifying an individual’s background,
qualifications, and specific scenarios that require onsite visit.
The thorough work ADatum Corporation performs results in highly accurate cases with minimal critical information missing. Because of these high-quality results, ADatum Corporation is quickly proving itself as one of the
best in the industry. In recent months, business has significantly increased, with most new business coming from high-profile companies and individuals.
Management has decided to create a new qualification verification (QV) role to help ensure that clients get the most accurate results. This role examines completed work to ensure that nothing is missed.
Current environment
Data storage and retention
All information sent by clients for services is stored in Microsoft Dataverse with a model-driven app as the interface.
Clients enter their data in a website, which then uses a service account to create the records in the Dataverse database.
Team members currently have full access to all Service Request records.
Service requests
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The Service Request table includes header information about the individual or organization that is the subject of verification.
New Service Request records are assigned to a queue. All potential users who will be performing the verifications have access to these records.
A service request is assigned to a single user who will ensure that all qualifications are verified. This single user is the only one able to process Qualification records related to their own service requests.
Many required tasks when performing verification services are currently done by using manual processes.
To keep up with demand, ADatum Corporation identifies several processes that can be replaced by using Power Automate flows to hire fewer new staff and keep costs down.
Qualification verification
The qualification table contains details about an individual school degree, professional qualifications, and other qualifications that must be verified.
A service request can have one or more Qualification records associated with it.
Record status is pending verification until the initial team member finishes, at which point the member changes the status to Complete.
When all qualification records related to a service request are verified either by manual or automated processes, the results are made available to ADatum Corporation’s client.
In the rare event that results are questioned, a new service request is created and verified independently of the previous work that took place.
To complete a service request, users perform the following actions:
Send a templated email by using Microsoft Outlook to the client after all qualifications for a service request are checked.
Change the service request status to Completed. Currently, service requests do not indicate when all Qualification records are addressed.
Microsoft Power platform environment
The following environments exist: development, testing, user acceptance testing (UAT), and production.
Managed solutions are used to move customizations from the development environment to other higher-level environments. These solutions are created and maintained by the power users and provided to internal IT for
deployment when they are ready.
Two managed solutions, Verification Process Automation and Onsite Visit, share several components.
All customizations to Power Platform components are performed by several power users who have received training and are certified as subject matter experts.
Power users have been granted the System Administrator security role in the development environment.
Corporate policy prohibits power users from writing code due to lack of a formal code review process.
Internal IT will not be able to supply any development resources for this project due to a lack of staff.
This means that any customizations and automation created for this project must be low-code/nocode for the power users to implement them.
Customizations created by power users are deployed by internal IT.
Requirements
Process automation
ADatum Corporation plans to establish a new QV department to verify completed work so that the quality of work is maintained. The new process for verifying professional qualifications must automate the following:
Enter data and navigate the authority’s website. The authority website UI changes frequently because the company constantly improves the user experience.
Search page contents for a specified value to determine validity.
Update the corresponding Qualification record in Dataverse.
The new process for completing a service request must automate the following:
Set the Service Request record status to Complete when work on all Qualification records is finished.
Send an email to the client with the results when the service request is completed. The email must list each qualification as either Valid or Not Valid, depending on the verification.
Qualification verification
Service request results will not be released to clients until all related Qualification records are set to a Complete status.
To check work done by a wide array of users, 10 percent of Qualification records must be double checked.
Qualification records must be automatically assigned to a queue.
Qualification records must be flagged with a new status field named Assigned to ensure that records are rechecked.
Ensure that only QV team members can change the status from Assigned to In Progress to Complete.
Record the name of the QV team member who performed the work and the date completed.
Governance and security
All components required for the verification process must be included in a new solution.
Corporate security requires that deployments to non-development environments must beautomated using service accounts.
User security and data access must also be consistent across environments, except for the elevated access of the power users in the development environment.
The Onsite Visit managed solution has a table that is not in the Verification Process Automation managed solution. This table must be upgraded prior to the go-live date without the other shared components.
A VP of sales requires a test environment to demonstrate to potential clients the security policies that are included in their initial offering.
Issues
More employees than are required can access individual client information and continue to have access after a service request is completed.
When users go on vacation, all their outstanding Service Request records are assigned to a substitute employee. The substitute employees are unable to see all the qualifications related to their service requests.

IT Certification Exams - Questions & Answers | Vdumps.com

https://vceplus.io
https://vceplus.io
https://vceplus.io/
https://vceplus.io
https://vdumps.com


Currently, testing the new QV functionality outside the development environment is not possible due to corporate security policies requiring the same security role across all environments.
Internal IT reports that the solution import to the test environment failed because of missing dependencies related to the flow for completing service requests.

QUESTION 1
HOTSPOT
You need to address the executive’s concerns regarding unnecessary data access.
Which security changes should you make? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:
Box 1: Assign records to a service account and add the team member doing the verification by using an access team. When to use access teams
* The teams are dynamically formed and dissolved. This typically happens if the clear criteria for defining the teams, such as established territory, product, or volume aren’t provided. * The team members require different
access rights on the records. You can share a record with several access teams, each team providing different access rights on the record. For example, one team is granted the Read access right on the account and another
team, the Read, Write and Share access rights on the same account.
* A unique set of users requires access to a single record without having an ownership of the record. Box 2: Assign records to the QV team when the service request is completed.
Issues: More employees than are required can access individual client information and continue to have access after a service request is completed. Management has decided to create a new qualification verification (QV)
role to help ensure that clients get the most accurate results. This role examines completed work to ensure that nothing is missed.
• When users go on vacation, all their outstanding Service Request records are assigned to a substitute employee. The substitute employees are unable to see all the qualifications related to their service requests.
Reference: https://docs.microsoft.com/en-us/power-apps/developer/data-platform/use-accessteams-owner-teams-collaborate-share-information

QUESTION 2
HOTSPOT
You need to resolve the issue reported by substitute employees after they are assigned service requests. How should you configure the system? To answer, select the appropriate options in the answer area.
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NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:

Section:
Explanation:
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Box 1: Service Request 1:N Qualification
When users go on vacation, all their outstanding Service Request records are assigned to a substitute employee. The substitute employees are unable to see all the qualifications related to their service requests. Box 2:
Cascade All
Cascade All - Perform the action on all referencing table records associated with the referenced table record.
Reference: https://docs.microsoft.com/en-us/power-apps/developer/data-platform/configure-entity-relationship-cascading-behavior

QUESTION 3
You need to implement the requirement for the VP of sales.
What should you do?

A. Use a test account with a base security role with QV security added.

B. Add the System Administrator security role to your user account.

C. Use a test account with only QV security added.

D. Add QV security to your user account.

Correct Answer: A
Section:
Explanation:
A VP of sales requires a test environment to demonstrate to potential clients the security policies that are included in their initial offering. Currently, testing the new QV functionality outside the development environment is
not possible due to corporate security policies requiring the same security role across all environments. Note: One of the security best practices in Dynamics 365 is to use the base security role as a baseline and apply that role
to all Users. The base security role will include all the common/basic permissions that are required to have access to the system.
To set up the base security role for the first time
create a new empty security role.
add the minimum privileges required to access the system.
add the privileges required for the basic functionalities.
test the role with the test user account.
add the permissions to the entities that all users can access (e.g. reference data).
Reference: https://linnzawwin.blogspot.com/2020/07/minimum-privileges-required-to-log-in.html

QUESTION 4
You need to be able to move a Power Automate desktop flow used in the verification process to the testing environment. What should you do?

A. Share a copy of the desktop flow with a member of internal IT.

B. Use the Export option in the flow to get the flow identifier and provide it to internal IT.

C. Send a copy of the desktop flow to a member of internal IT.

D. Create the desktop flow in a solution and provide it to internal IT.

Correct Answer: D
Section:
Explanation:
Internal IT reports that the solution import to the test environment failed because of missing dependencies related to the flow for completing service requests. Flows with PowerApps steps
Flows that were created via Power Automate in the PowerApps menu or flows that have PowerApps steps added have a different issue then other Power Automate flows. As of the writing of this blog these flows are not able
to be imported into another environment. This means that if you create flows with Power Apps steps within them you will need to recreate them in your destination environment.
Reference: https://www.spyglassmtg.com/blog/power-platform-solution-export-and-import-issues

QUESTION 5
HOTSPOT
You create a desktop flow to interact with a certification authority’s website.
You need to get data in and out of the desktop flow.
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How should you set up the input and output parameters? To answer, select the appropriate options
in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:

Section:
Explanation:
Box 1: Connect by using the Dataverse connector from the desktop flow and retrieve the qualification data. All information sent by clients for services is stored in Microsoft Dataverse with a model-driven app as the interface.
Qualification verification
The qualification table contains details about an individual school degree, professional qualifications, and other qualifications that must be verified. A service request can have one or more Qualification records associated
with it.
Record status is pending verification until the initial team member finishes, at which point the member changes the status to Complete. When all qualification records related to a service request are verified either by manual
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or automated processes, the results are made available to ADatum Corporation’s client. In the rare event that results are questioned, a new service request is created and verified independently of the previous work that took
place. Box 2: Send data from the desktop flow to a cloud flow to update the qualification record.
To complete a service request, users perform the following actions:
Send a templated email by using Microsoft Outlook to the client after all qualifications for a service request are checked. Change the service request status to Completed. Currently, service requests do not indicate when all
Qualification records are addressed.

QUESTION 6
HOTSPOT
You need to configure a Power Automate flow to send the email with the results to the client.
What should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:
Box 1: Apply to each
You can use the Apply to each action to process a list of items periodically.
Box 2: Do until
The Do Until control in Power Automate is a loop that repeatedly forces an action until a certain condition becomes true.
Reference: https://docs.microsoft.com/en-us/power-automate/apply-to-each
https://blog.enterprisedna.co/do-until-loop-control-in-power-automate/

QUESTION 7
You need to capture the Date Completed value from the website using a desktop flow.
Which method should you use?

A. Use optical character recognition (OCR) on the screen to locate and extract the value.

B. Display an input dialog and prompt the user to enter the value.

C. Extract the value from the window the browser is using.

D. Retrieve the value from the HTML element in the webpage.

Correct Answer: C
Section:
Explanation:
Record the name of the QV team member who performed the work and the date completed.

QUESTION 8
You need to assign 10 percent of the Qualification records to the QV queue through table configuration by using a Power Automate flow. What should you do?

A. Create an autonumber column on the Qualification table and assign its qualification records if the number cleanly divides by 10.

B. Create a calculated column on the Service Request table that sums the number of qualification records, generates a random number between zero and the number from the new field, and assigns each qualification
record if the number generated is 10 percent or less of the value of the new field.
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C. Create a roll-up column on the Service Request table that is the count of qualification records, generates a random number between zero and the number from the new field, and assigns each qualification record if the
number generated is 10 percent or less of the value of the new field.

D. Create an autonumber column on the Service Request table and assign its qualification records if the number cleanly divides by 10.

Correct Answer: B
Section:

QUESTION 9
HOTSPOT
You need to configure a Power Automate flow to send the email with the results to the client.
What should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:
Box 1: Set Table table to Qualification and Column filter to statuscode.
Box 2: Loop through related qualification records and complete if all are in Complete status.
The new process for completing a service request must automate the following:
Set the Service Request record status to Complete when work on all Qualification records is finished. Send an email to the client with the results when the service request is completed. The email must list each qualification as
either Valid or Not Valid, depending on the verification.

QUESTION 10
You need to set up the new service request completion process.
Which two components should you include in the solution? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. connection reference

B. business process flow

C. Power Automate flow

D. connection

Correct Answer: A, C
Section:
Explanation:
Reference: https://docs.microsoft.com/en-us/power-apps/maker/data-platform/create-connectionreference

QUESTION 11
You need to add the missing components to the Verification Process Automation solution.
Which two components should you add? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Service Request statuscode field

B. Dataverse connection reference
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C. Qualification statuscode field

D. On-premises data gateway reference

E. Outlook connection reference

Correct Answer: C, E
Section:
Explanation:
C: A service request can have one or more Qualification records associated with it.
E: The new process for completing a service request must automate the following:
• Set the Service Request record status to Complete when work on all Qualification records is finished.
• Send an email to the client with the results when the service request is completed. The email must list each qualification as either Valid or Not Valid, depending on the verification.

QUESTION 12
HOTSPOT
You need to coordinate updates and deployment for managed solutions containing completed work without disrupting the system. What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:
Box 1: Deploy a patch with the changes made from the current solution.
Scenario:
The Onsite Visit managed solution has a table that is not in the Verification Process Automation managed solution. This table must be upgraded prior to the go-live date without the other shared components. Box 2: Deploy a
full copy of the original solution using the upgrade option. Then, deploy the new solution by using the update option. Scenario: All components required for the verification process must be included in a new solution.
Corporate security requires that deployments to non-development environments must be automated using service accounts. Managed solutions are used to move customizations from the development environment to other
higher-level environments. These solutions are created and maintained by the power users and provided to internal IT for deployment when they are ready.
Note:
Upgrade This is the default option and upgrades your solution to the latest version and rolls up all previous patches in one step. Any components associated to the previous solution version that are not in the newer solution
version will be deleted. This is the recommended option as it will ensure that your resulting configuration state is consistent with the importing solution including removal of components that are no longer part of the
solution. Update This option replaces your solution with this version. Components that are not in the newer solution won't be deleted and will remain in the system. This option is not recommended as your destination
environment will differ in configuration from your source environment and could cause issues that are difficult to reproduce and diagnose.
Reference: https://docs.microsoft.com/en-us/power-apps/maker/data-platform/update-solutions

Exam F

QUESTION 1
HOTSPOT
A company has a sales application that is supported by an Azure SQL database. You are developing a Power Apps app for use by customer service agents. The app must reference customer data from the sales application. Data
in the sales application is constantly changing and must not be replicated in Microsoft Dataverse Some customer data is considered sensitive. You must protect data for specific fields when users view data in the app.
You need to configure table creation for the app.
How should you configure the app? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point

Hot Area:
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Answer Area:

Section:
Explanation:

QUESTION 2
HOTSPOT
You are creating a business process flow for a Power Apps app.
The business process flow must meet the following requirements:
• Must be available offline.
• Send an email to the team when a record is created.
You need to set up business process flow.
What should you do? To answer, select the appropriate options in the answer area.
Each correct selection is worth one point

Hot Area:
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Answer Area:

Section:
Explanation:

QUESTION 3
HOTSPOT
You are a consultant. A client asks you to remove several solutions in one of their Microsoft Dataverse environments The client wants to know what effect removing the solutions will have on the rest of the system. You need
to explain the results of removing the solutions.
Which components be affected? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:
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Answer Area:

Section:
Explanation:

QUESTION 4
DRAG DROP
You modify a model-driven app for a bicycle repair help desk. The model-driven app is for help desk users when customers have an issue with their bicycle. After you add a custom table named bicycle, you configure the table
for Microsoft Dataverse search.
The table will contain information from callers about their bicycles. The account table is related to the custom table. Contact information is brought over to the custom table. You add the following columns to the table:
•Bicycle type
•Tire brand
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•Special equipment
Users must be able to perform the following types of searches:
•Search for all customers who have a bicycle type of Contoso and live in Florida.
•Search all tables for any record that contains the word broken.
•You need to decide which type of search will give you the results desired.
Which search should you configure? To answer, drag the appropriate search types to the correct requirements. Each search type may be used once, more than once, or not at all. You may need to drag the split bar between
panes or scroll to view content.
NOTE: Each correct selection is worth one point.

Select and Place:

Correct Answer:

Section:
Explanation:
Box 1: Advanced find
Operators for advanced search: Lets you use simple Boolean operators in your search term and craft the query to get the results you want. Box 2: Dataverse search
Dataverse search helps you quickly find what you're looking for. It delivers fast and comprehensive results across multiple tables in a single list, sorted by relevance.
Reference: https://docs.microsoft.com/en-us/power-apps/user/quick-find
https://docs.microsoft.com/en-us/power-platform/admin/configure-relevance-search-organization

QUESTION 5
HOTSPOT
You are designing the organization structure for a company that has 5,000 users.
You need to configure security roles for the company while minimizing administrative effort.
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What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:

Section:
Explanation:
Box 1: Create a new team, and the business unit users, and the assign the security role to the team. Change the business unit for a team
Important
By changing the business unit for a team, you can remove all security role assignments for the team. At least one security role must be assigned to the team in the new business unit.
•Select an environment and go to Settings > Users + permissions > Teams.
•Select the checkbox for a team name.
•Screenshot selecting a team.
•On the menu bar, select Change Business Unit.
•In the Change Business Unit dialog box, select a business unit. Enable Move records to new business unit to move to a new business unit. Select OK. Box 2: Grant the user a security role from the child business unit.
Reference: https://docs.microsoft.com/en-us/power-platform/admin/create-edit-business-units
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https://docs.microsoft.com/en-us/power-platform/admin/security-roles-privileges

QUESTION 6
HOTSPOT
You are setting up Power Apps security for a company. The company has a CEO, two vice presidents, and 10 managers. Five support representatives report to each manager. You set up Manager Hierarchy so managers are able
to view data only for the representatives who report to them. The CEO must be able to view all data for everyone. All support representatives must be able to view customer information in each other’s data across all
managers.
You need to resolve issues that arise during testing.
What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:
Box 1: Move the manager and reports to a separate business unit.
Keep the Manager hierarchy, and put the reports to the appropriate business unit.
Note: Two security models can be used for hierarchies, the Manager hierarchy and the Position hierarchy. With the Manager hierarchy, a manager must be within the same business unit as the report, or in the parent business
unit of the report’s business unit, to have access to the report’s dat a. The Position hierarchy allows data access across business units. If you are a financial organization, you may prefer the Manager hierarchy model, to
prevent managers’ accessing data outside of their business units. However, if you are a part of a customer service organization and want the managers to access service cases handled in different business units, the Position
hierarchy may work better for you. Box 2: Add the CEO to the representative user record as a manager.
Set up Manager and Position hierarchies
The Manager hierarchy is easily created by using the manager relationship on the system user record. You use the Manager (ParentsystemuserID) lookup field to specify the manager of the user. Note: Depth is used to limit
how many levels deep a manager has Read-only access to the data of their reports. For example, if the depth is set to 2, the CEO can see the data of the VP of Sales, VP of Service and Sales and Service Managers. However, the
CEO doesn’t see the Sales data or the Support data.

Box 3: Add users to field security
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Power Platform's field-level security lets you set which fields users can see or edit.
Reference: https://docs.microsoft.com/en-us/power-platform/admin/hierarchy-security
https://docs.microsoft.com/en-us/power-platform/admin/field-level-security

QUESTION 7
DRAG DROP
You are configuring Microsoft Dataverse security. You plan to assign users to teams.
Record ownership and permissions will differ based on business requirements.
You need to determine which team types meet the requirements.
Which team type should you use? To answer, drag the appropriate team types to the correct requirements. Each team type may be used once, more than once, or not at all. You may need to drag the split bar between panes
or scroll to view content.
NOTE: Each correct selection is worth one point.

Select and Place:

Correct Answer:
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Section:
Explanation:
Box 1: Microsoft Teams team
Dataverse supports two types of record ownership. Organization owned, and User or Team owned.
This is a choice that happens at the time the table is created and can’t be changed. For security purposes, records that are organization owned, the only access level choices is either the user can do the operation or can’t. For
user and team owned records, the access level choices for most privileges are tiered Organization, Business Unit, Business Unit and Child Business Unit or only the user’s own records. That means for read privilege on contact,
I could set user owned, and the user would only see their own records. Box 2: Access team
An access team doesn’t own records and doesn’t have security roles assigned to the team. The team members have privileges defined by their individual security roles and by roles from the teams in which they are members.
The records are shared with an access team and the team is granted access rights on the records, such as Read, Write or Append.
Reference:
https://docs.microsoft.com/en-us/power-platform/admin/wp-security-cds
https://docs.microsoft.com/en-us/powerapps/developer/data-platform/use-access-teams-ownerteams-collaborate-share-information

QUESTION 8
HOTSPOT
A company uses a canvas app to manage production resources in a specific region. Employees must be at company locations to use the app. Due to a sudden requirement for employees to work remotely, employees no
longer commute to a specific location to conduct their work and cannot access the canvas app. You must reconfigure the app to ensure that employees only access the app from a limited number of locations. You need to
restrict access to the app.
Which components should you configure? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Hot Area:
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Answer Area:

Section:
Explanation:
https://docs.microsoft.com/en-us/power-platform/admin/restrict-access-online-trusted-ip-rules

QUESTION 9
DRAG DROP
A company is creating a canvas app and a model-driven app to manage their customer accounts.
The canvas app requires a business rule to set the Business Type column to large if the customer size is greater than a specific currency value. The model-driven app requires a business rule to recommend the account rating
be re-evaluated when the account goes on credit hold for this app only. You need to configure the scope for the business rules.
Which scope should you use? To answer, drag the appropriate scopes to the correct business rules.
Each scope may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content. NOTE: Each correct selection is worth one point.

Select and Place:
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Correct Answer:

Section:
Explanation:
Box 1: Table
The canvas app requires a business rule to set the Business Type column to large if the customer size is greater than a specific currency value. Scope the business rule to Entity (Table).
Box 2: Specific form
The model-driven app requires a business rule to recommend the account rating be re-evaluated when the account goes on credit hold for this app only. For Model
The scope of the business rule determines which forms the business rule will be applied. You set the scope, according to the following:
If you select this item...
The scope is set to...
Entity- The table and all forms for the table
All Forms- All forms for the table
Specific form (account Main Form, for example) - Just that form
Reference: https://debajmecrm.com/business-rules-in-powerapps-canvas-apps/
https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-business-rulesrecommendations-apply-logic-form

QUESTION 10
HOTSPOT
You have a Power Apps portal app that supports a sales community and a service community in the same environment. The only language configured in the environment is English. The company wants to add support for two
more languages.
The solution must meet the following requirements:
•Languages must be for both sales and service functions.
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•The company logo and colors must be used and apply to all screens.
•Communities must be separate with different URLs and access lists.
You need to configure the solution.
What should you configure? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:

Section:
Explanation:
Box 1: Create two portals, one for each community
Power Apps portal app languages
Box 2: Add themes
You can create a custom look and feel (a theme), for your app by making changes to the default colors and visual elements provided in the uncustomized system. For example, you can create your personal product branding
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by adding a company logo and providing table-specific coloring. A theme can be created by using the Themes area, without requiring a developer to write code. You can create, clone, change, or delete themes that are used in
your environment.
Reference: https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-themesorganization-branding

QUESTION 11
DRAG DROP
You are customizing a model-driven app for a company. You create a Theme template to ensure the company logo and colors are properly used within these apps. The theme must meet the following requirements:
•Updated to add the logo
•Downloaded by the makers to create the app
You need to configure the assets. To answer, drag the appropriate configurations to the correct requirements. Each configuration may be used once, more than once, or not at all. You may need to drag the split bar between
panes or scroll to view content.
NOTE: Each correct selection is worth one point.

Select and Place:

Correct Answer:
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Section:
Explanation:
Box 1: Upload the theme elements as new web resources.
Each type of icon is stored as a web resource. Create a web resource first and then set the icons to use them. Alternatively, you can add the icon by creating a new web resource when you define the table properties. Box 2:
Replace an existing UI item's hexadecimal number.
Copy and alter the existing theme
The easiest and quickest way to create a new theme is to clone and alter an existing theme. Then save, preview, and publish it.
•Sign in to Power Apps, select Settings icon (upper right), and then select Advanced settings.
•Select Customizations, and then select Themes.
•Under All themes, select the theme you want to clone, such as the CRM Default Theme. Select Clone on the command bar.
•Replace an existing UI item's hexadecimal number, such as the Title Text Color, with the hexadecimal value that represents the color you want. For example, the CRM Default Theme was cloned and changed using mostly
varying shades of green color. The following screenshots show the new colors for navigation and highlighting. A custom logo was also added that will appear in the upper left corner of an app.
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Reference: https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/create-themesorganization-branding

QUESTION 12
DRAG DROP
You create a new solution for a business process.
The business process includes uploading specific file types to a web service.
You need to ensure that the business process works the same way anywhere the solution is deployed.
Which option should you use? To answer, drag the appropriate options to the correct configurations.
Each option may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

Select and Place:
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Correct Answer:
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Section:
Explanation:
Box 1: Solution system settings
For Power Apps in Settings > Customizations > Customize the System you can configure email and document management, activate or deactivate processes, and more. Box 2: Environment variable
When should Environment variables be used?
Some examples include:
When an input parameter needs to change across environments and should not be hard-coded. For example, a URL that points to a different resource in development and production environments. If you’re building a
solution where your customer is required to provide an input value.
Application setup pages.
Incorrect:
A connection reference is a solution component that contains information about a connector.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/advanced-navigation
https://powerapps.microsoft.com/en-us/blog/environment-variables-available-in-preview/

QUESTION 13
HOTSPOT
A company is configuring a Power Apps portal using Microsoft Dataverse.
The company requires the following:
•Only authenticated users must be able to sign into the portal.
•Authenticated users must have varying degrees of access to the different parts of the portal.
•Users must enter one of several external identities when creating an account during the open registration process. You need to configure user authentication and permissions.
Which component should you use? To answer, select the appropriate options in the answer area.
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NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:
Box 1: Contact table record
In Power Apps portals, each authenticated portal user is associated with a contact record in Microsoft Dataverse. Box 2: Web roles
Portal users must be assigned to web roles to gain permissions beyond unauthenticated users.
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/portals/configure/configure-portal-authentication

QUESTION 14
HOTSPOT
A company uses Power Apps and Power Automate.
There is an issue with the existing flow in the test environment. Development changes are allowed in the test environment. You need to troubleshoot the issue with the flow.
Which command should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:
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Answer Area:

Section:
Explanation:

QUESTION 15
HOTSPOT
A bank uses Power BI visualizations to help determine whether they should loan money to a customer. The bank has three different visuals that are part of a Power BI report. The bank uses a set of four risk variables that
indicate whether the customer is creditworthy.
You must create a mechanism so that bank employees can change the values of the four risk variables. Changes to the value of any variable must cause the three visualizations to update. You need to create the solution.
Which action should you perform? To answer, select the appropriate options in the answer area.
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NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:

Section:
Explanation:
Box 1: Embed a Power BI report in a model-driven app
You can embed a Power BI report in a model-driven app main form.
Box 2: Use the Power BI service.
The Power BI cloud service works with Microsoft Dataverse apps to provide a self-service analytics solution. Power BI automatically refreshes the app's data displayed. With Power BI Desktop or Microsoft Excel, Power Query
for authoring reports and Power BI for sharing dashboards and refreshing data from model-driven apps, your users have a powerful way to work with your app's data.
Reference: https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/embed-powerbireport-in-system-form https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/use-power-bi

QUESTION 16
HOTSPOT
A company uses a model-driven Power Apps app in a new environment. The base language is English.
You need to configure French and Spanish.
Which configuration component should you use? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Hot Area:
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Answer Area:

Section:
Explanation:
Box 1: Language packs
Before users can start using a Language Pack to display a language, the Language Pack must be enabled in your organization. Box 2: Environment
Enable the language
These settings can be found in the Microsoft Power Platform admin center by going to Environments
> [select an environment] > Settings > Product > Languages.
Reference: https://docs.microsoft.com/en-us/power-platform/admin/enable-languages
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QUESTION 17
DRAG DROP
A company has employees in France, Mexico, and the United States. You are creating a Power Apps app to allow users to add client records to Microsoft Dataverse. The default language for the company is English. The
company wants the app to display each local language.
You need to add the Spanish and French languages.
Which four actions should you perform in sequence for each language? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the correct order.

Select and Place:

Correct Answer:
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Section:
Explanation:
Step 1: Select an unmanaged solution.
Export the localizable text
The scope of the localizable text that will be exported is the unmanaged solution that contains the localizable text.
•From Power Apps, select Solutions.
•In the All Solutions list, select the unmanaged solution that contains the localizable text you want.
•On the command bar, select Translations > Export Translations.
Step 2: Export translations.
Step 3: Add a language code column and a translated wording in the CrmTranslations.xml file.
Get the localizable text translated
You can send this file to a linguistic expert, translation agency, or localization firm.
If you have the knowledge to translate the text, or if you just want to see the format, you can extract the zip file that you exported you will see that it contains two XML files. [Content_Types].xml
CrmTranslations.xml
You can open the CrmTranslations.xml file with Microsoft Office Excel.
When you view the data in Excel, look at the Localized Labels tab.
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Any custom tables or columns will have empty cells for the localizable text. Add the localized values for those items. Step 4: Import translations.
Import the localized text
Importing the text requires compressing the files and importing them into the system.
Import the files
From the same unmanaged solution that you exported the translations from, in the menu choose Translations > Import Translations. Note: If you have customized table or column text, such as column labels or drop-down list values, you can
provide the users in your environment who are not working with the base language version of your environment with this customized text in their preferred languages.
The process has the following steps:
•Enable other languages for your environment
•Export the localizable text
•Get the localizable text translated
•Import the localized text
Reference: https://docs.microsoft.com/en-us/power-apps/maker/model-driven-apps/translatelocalizable-text

QUESTION 18
HOTSPOT
You create a Power Automate flow as part of a managed solution. The flow alerts users when files are uploaded to a SharePoint location. Files are uploaded to SharePoint at a much higher rate than expected. Users report
that they receive too many notifications about uploaded files. You need to stop the flow and correct the issue.
What should you do? To answer, select the appropriate options in the answer area.

Hot Area:

Answer Area:
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Section:
Explanation:
https://docs.microsoft.com/en-us/power-automate/edit-solution-aware-flow
https://docs.microsoft.com/en-us/power-automate/error-checker

QUESTION 19
HOTSPOT
You create a Power Platform help Desk solution.
You need to create a dashboard that displays information on help desk cases that are handled each week. Which dashboard components should you use? To answer, select the appropriate options in the answer area. NOTE:
Each correct selection is worth one point.

Hot Area:
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Answer Area:
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Section:
Explanation:
Box 1: Area chart
Box 2: System chart
System charts are organization-owned charts, which makes them available to anyone with access to read the data running the app. System charts can't be assigned or shared with specific app users. Box 3: Personal dashboard
Box 4: Personal dashboard
Box 5: Area chart
Reference:
https://docs.microsoft.com/en-us/powerapps/user/add-powerbi-dashboards
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-system-chart

QUESTION 20
You plan on implementing complex business logic in Microsoft Dataverse tables by using Power Automate flows. You realize that the functionality required to implement the business logic is not available in a Power Automate
flow. The new business logic must work in multiple Dataverse tables. In addition, the operation must return a value after it finishes and must be able to run from an existing Dataverse action. You need to recommend the
method to implement the missing logic.
What should you recommend?

A. Scheduled workflow

IT Certification Exams - Questions & Answers | Vdumps.com

https://docs.microsoft.com/en-us/powerapps/user/add-powerbi-dashboards
https://docs.microsoft.com/en-us/powerapps/user/add-powerbi-dashboards
https://docs.microsoft.com/en-us/powerapps/user/add-powerbi-dashboards
https://docs.microsoft.com/en-us/powerapps/user/add-powerbi-dashboards
https://docs.microsoft.com/en-us/powerapps/user/add-powerbi-dashboards
https://docs.microsoft.com/en-us/powerapps/user/add-powerbi-dashboards
https://docs.microsoft.com/en-us/powerapps/user/add-powerbi-dashboards
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-system-chart
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-system-chart
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-system-chart
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-system-chart
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-system-chart
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-system-chart
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-system-chart
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-system-chart
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-system-chart
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-system-chart
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-system-chart
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-system-chart
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-system-chart
https://vceplus.io
https://vceplus.io
https://vceplus.io/
https://vceplus.io
https://vdumps.com


B. Bound action

C. Custom API

D. Unbound action

Correct Answer: D
Section:

QUESTION 21
A Company plans to send escalation emails to all customers with overdue invoices. You are creating a Microsoft Power Automate flow to determine whether to send an escalation email. The system must send an alert for all
invoices that are seven days or more overdue.
You need to configure the flow.
Which expression should you use?

A. Option A

B. Option B

C. Option C

Correct Answer: C
Section:
Explanation:
Example: equals(triggerOutputs()?[‘body/PDFStatus/Value’],’Ready to Generate’)
Reference:
https://evolvous.com/microsoft-power-automate-trigger-condition/

QUESTION 22
You are configuring a new Power Apps portal. You have two web roles, one for authenticated users and one for anonymous users. You grant the Anonymous Users role to users. A test user reports that they can access the
home page but cannot view a page linked from the home page. You need to determine why the test user cannot view the portal page.
What is the cause of the issue?

A. Maintenance mode is enabled on the portal.

B. The setting to make the page available to everyone is disabled.

C. The Authenticated Users Web role does not have permission to view the page.

D. Inherited permissions are not enabled for the linked page.

Correct Answer: C
Section:

QUESTION 23
You are using the Data import wizard to import records into the account table from a CSV file.
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The CSV-to-table mapping is as following:
• Name column represents the account and maps to the Account column.
• TIE Parent Name column represents the holding company of the account with subsidiaries underneath Records that are imported into the table are only related to other records in the file. You need to configure the import
to create the relationship between records.
What should you do?

A. Map Parent Name in the CSV file to the Parent Account column. Select Account as lookup criteria

B. Lookup the record IDs Of the records in the ParentAccount column. Add the record IDs new column in the file. Map the new column to the ParentAccount column.

C. Map Parent Name in the file to the Parent Account column. Select Parent Account as lookup criteria

D. Create an alternate key the account table by using the Account Name column. DO not map parent Name in file.

Correct Answer: C
Section:

QUESTION 24
A company creates a Microsoft Power Apps app through the Power Apps designer portal for use in Microsoft Teams. This app needs to be promoted to the user acceptance testing environment.
You reed to complete the Microsoft recommended actions before you export the solution.
Which two actions should you complete? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. Write validation tests.

B. Set the Optimized embedding appearance field to true.

C. Publish all changes.

D. Run the solution checker.

E. Clone a solution.

Correct Answer: D, E
Section:
Explanation:
The Power Apps solution checker performs a rich static analysis check on your solutions against a set of best practice rules to quickly identify problematic patterns. After the check completes, you receive a detailed report that
lists the issues identified, the components and code affected, and links to documentation that describes how to resolve each issue. The solution checker analyzes these solution components:
Common Data Service plug-ins
Common Data Service custom workflow activities
Common Data Service web resources (HTML and JavaScript)
Common Data Service configurations, such as SDK message steps

QUESTION 25
A company is training an Al model using a custom table to determine the amount of time it takes to deliver a package based on several key fields. The testing data used to train the model is used for all training and regression
testing scenarios and is considered complete dat a. The trained model predicts a 2 percent variance between the estimated delivery time and the actual delivery time of packages. The executive sponsors reject the model
because the actual variance is at 15 percent.
You need to address the sponsors' concern
What should you do?

A. Reduce the size of the data used within the model.

B. increase the size of the data used with the model.

C. Use sample training data from Microsoft

D. Replace the training data with real-world data.
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Correct Answer: C
Section:

QUESTION 26
Your organization does not permit the use of custom code for solutions.
You need to create a view that can be viewed by all users in an organization.
Where should you create the view?

A. Microsoft Visual Studio

B. Maker portal

C. Advanced Find

D. System Settings

Correct Answer: C
Section:
Explanation:
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/create-edit-views-appdesigner

QUESTION 27
You are embedding a Power Apps visual in a Power BI dashboard.
External customers must authenticate to have access to the dashboard.
You need to configure the solution.
Which two actions should you perform? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. Set the Power Bl service to authenticate users.

B. Use a table in the Power Bl dashboard.

C. Publish to Power Bl Report Server.

D. Set the Power Bl service to allow anonymous access.

E. Share the Power Apps visual components with external users.

Correct Answer: A, E
Section:
Explanation:
Power BI uses Azure Active Directory (AAD) to authenticate users who sign in to the Power BI service, and in turn, uses the Power BI login credentials whenever a user attempts to access resources that require authentication.
Users sign in to the Power BI service using the email address used to establish their Power BI account; Power BI uses that login email as the effective username, which is passed to resources whenever a user attempts to
connect to data. The effective username is then mapped to a User Principal Name (UPN) and resolved to the associated Windows domain account, against which authentication is applied.
Reference: https://docs.microsoft.com/en-us/power-bi/enterprise/service-admin-power-bi-security

QUESTION 28
You attempt to deactivate several currencies in a Microsoft Dataverse environment.
You are not able to deactivate one of the currencies.
You need to determine why you cannot deactivate the currency.
What is the reason?

A. You are not the currency record owner.

B. The currency is used by an active business process.
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C. The currency is the base currency.

D. The currency is used by another record.

Correct Answer: C
Section:
Explanation:
Reference:
https://docs.microsoft.com/en-us/powerapps/developer/data-platform/org-service/web-service-errorcodes https://docs.microsoft.com/en-us/power-platform/admin/manage-transactions-with-multiple-currencies

QUESTION 29
A user needs to create a Power Apps portal app.
The user is getting a permission denied error when creating the portal app.
You need to configure permissions to create the portal app.
Which three permissions should you configure? Each correct answer presents part of the solution.
NOTE: Each correct selection is worth one point.

A. In the Power Platform admin center, ensure that the user account has read-write access.

B. In Azure Active Directory, assign the Contributor role to the application at the subscription scope.

C. In Azure Active Directory, ensure that the user has permission to register an app.

D. In the Power Platform admin center, change the portal app owner to the user.

E. In the Power Platform admin center, ensure that the user has the System administrator security role.

Correct Answer: A, C, E
Section:
Explanation:
Reference: https://docs.microsoft.com/en-us/power-apps/maker/portals/create-common-problems
https://docs.microsoft.com/en-us/power-apps/maker/portals/create-portal
https://docs.microsoft.com/en-us/azure/active-directory/develop/howto-create-service-principalportal#required-permissions

QUESTION 30
A company collaborates by using Microsoft Teams.
You must create a Power Apps app directly from within a Teams channel. The app will be used by members of the channel to manage sales orders. You need to create the app by using Dataverse for Teams.
How should you create the app?

A. Create a canvas app by using a Power Apps personal app in Teams.

B. Create a canvas app by using the App Studio app.

C. Use the Power Apps web designer.

D. Create a model-driven app by using the App Studio app

Correct Answer: B
Section:
Explanation:
You can create, edit, and delete canvas apps in Teams.
Note: With Power Apps Studio embedded in the Power Apps app in Teams and the new built-in data platform providing an easy-to-use, editable data table, you can quickly build apps based on custom data tables that are
Teams-specific and scenario-specific.
Reference: https://docs.microsoft.com/en-us/power-apps/teams/create-first-app
https://docs.microsoft.com/en-us/power-apps/teams/create-apps-overview
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QUESTION 31
A farm uses a canvas app to manage schedules for planting fields with crop seeds. The farm uses business intelligence to provide recommendations for schedule changes based on weather data. You must implement a
business rule that changes information for several forms in the canvas app based on business intelligence data. You need to configure the business rule.
Which scope should you use?

A. Table

B. All Forms

C. Form specific

Correct Answer: A
Section:

QUESTION 32
DRAG DROP
You are modifying a model-driven app. You set up a customer table in Microsoft Power Platform to retrieve user data. You set up a form with the following columns for users to enter their data. The form includes the following
columns:

The form must do the following:
• The Country/region column must automatically populate with US when English is chosen as a language. If the user selects Other for this column, the column must remain blank so that user can enter a value.
• The Passport expiration date column must appear only if the user selects Yes in the Passport ownership column. You need to configure the app with the least amount of effort.
What should you configure? To answer, drag the appropriate solution component to the correct requirements. Each solution component may be used once, more than once, or not at all. You may need to drag the split bar between panes or
scroll to view content.
NOTE: Each correct selection is worth one point.

Select and Place:

Correct Answer:
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Section:
Explanation:

QUESTION 33
DRAG DROP
The app needs to store temporary data
• Each screen must maintain a separate copy of data and pass the data to another screen.
• The app must be able to update separate rows of a table independently.
You need to configure variables for the data.
Which variable types should you use? To answer, drag the appropriate variable types to the correct requirements. Each variable type may be used once, more than once, or not at all. You may need to drag the split bar
between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

Select and Place:

Correct Answer:
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Section:
Explanation:

QUESTION 34
You create a Power Apps app.
The app must be able to display a list of records that are sorted by category. The app must also expand or hide the list by subtopics. You need to configure the app.
Which tool should you use?

A. card

B. expression

C. Power Bl dashboard

D. gallery

Correct Answer: D
Section:
Explanation:
A gallery control in Power Apps allows you to display a list of records, and can be configured to sort the records by a specific field, such as category. Additionally, the gallery control has built-in functionality for expanding or hiding a list of
subtopics. This can be done by adding a toggle control within the gallery template to show or hide the subtopics based on user interaction. Reference:https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/controls/control-gallery

QUESTION 35
A veterinary office plans to use Microsoft Power Platform to streamline customer experiences. The customer creates a canvas apps to manage appointments. On the client appointment form, there is a dropdown field for
clients to select their type of pet. If a client selects the option Other, a text field must appear so that staff members can add details about the pet. You need to create a dynamically visible field.
What should you configure?

A. business rule

B. business process flow

C. workflow

Correct Answer: A
Section:
Explanation:

QUESTION 36
A company uses Power Apps with Microsoft Dataverse.
The company enables auditing on the Dataverse database. The company tenant reaches the maximum storage capacity. You need to delete some auditing data.
Which three deletion options should you use? Each correct answer presents a complete solution.
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NOTE: Each correct selection is worth one point.

A. by table

B. by record

C. between two specified dates

D. by column

E. older than a specified date

Correct Answer: A, C, E
Section:
Explanation:
A. Deleting by table allows you to select specific tables in the Dataverse database for which you want to delete the auditing data. This can be done by going to the Power Apps portal, navigating to the Data tab, and selecting the table for which
you want to delete the auditing data. You can then select the specific auditing data you want to delete and click the "Delete" button. This is useful if you want to only delete auditing data for specific tables and not for the entire database.
Reference:https://docs.microsoft.com/en-us/power-platform/admin/data/data-management-auditing#delete- audit-logs

C. Deleting between two specified dates allows you to select a range of dates within which the auditing data will be deleted. This can be done by going to the Power Apps portal, navigating to the Data tab, and selecting the "Audit" option. From
there, you can select the "Delete" button, and select the "Between two dates" option. Then you can specify the start and end date for which you want to delete the auditing data. This is useful if you want to delete auditing data for a specific
time periodand not for the entire database. Reference: https://docs.microsoft.com/en-us/power- platform/admin/data/data-management-auditing#delete-audit-logs

E. Deleting older than a specified date allows you to select a specific date, and any data older than that date will be deleted. This can be done by going to the Power Apps portal, navigating to the Data tab, and selecting the "Audit" option. From
there, you can select the "Delete" button, and select the "Older than a specified date" option. Then you can specify the date for which you want to delete the auditing data. This is useful if you want to delete auditing data that is older than a
certain date andnot for the entire database. Reference: https://docs.microsoft.com/en-us/power- platform/admin/data/data-management-auditing#delete-audit-logsIt's always good to have a backup of Data before deletion and also check the
retention period of the data you want to delete.

QUESTION 37
DRAG DROP
You make the following customizations to a Microsoft Dataverse Environment
• Create a new table

• Add data to the new table.
• Delete an unused area from the site map.
The components must be transported to a different environment.
You need to determine the method required to transport each component.
Which method should you use? To answer, drag the appropriate methods to the correct components.
Each method may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content. NOTE: Each correct selection is worth one point.

Select and Place:
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Correct Answer:

Section:
Explanation:

QUESTION 38
A company is planning to create a Power Virtual Agents bot.
The bot has the following requirements:
• The bot must provide address information for the company.
• The bot must be available from Microsoft Teams and from the internet website of the company.
You need to configure the bot. Which component should you use?

A. Skill

B. Composer

C. Template

D. Channel

Correct Answer: D
Section:
Explanation:

QUESTION 39
A company creates a model-driven app.
Users require access to a Power Bl report that is embedded in the app.
You need to configure the app.
Where should you add the report?

A. XML report

B. Dashboard

C. Business rule

D. Power Automate cloud flow

Correct Answer: B
Section:
Explanation:
To add a Power BI report to a model-driven app, you should add it to a dashboard. Dashboards in model-driven apps provide a way to organize and display information, such as charts, tables, and reports. You can add a Power BI report to a
dashboard by creating a new dashboard and then adding a Power BI report component to it. This component allows you to specify the report you want to add and configure its properties, such as size and layout. Users will then have access to
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the embedded report when they view the dashboard in the app. Reference: https://docs.microsoft.com/en-us/power-platform/admin/create-model-driven-app-dashboards

QUESTION 40
You plan to create a dataflow by using Power Query to transform the data. You observe 'hat some cells display an error instead of the expected data. You need to obtain more details about the errors. What should you do?

A. Select the row that includes the cell with the error.

B. Use the Flow Checker.

C. Select the cell with the error.

D. Use the App Checker.

E. Use the Advanced Editor.

Correct Answer: C
Section:

QUESTION 41
HOTSPOT
You plan to create a dataflow to import data into Microsoft Dataverse by using Power Query. The dataflow has the following requirements:
• A table of aggregated data must be created in dataflow storage.
• A unique identifier must be created for the table.
You need to configure the dataflow.
Which solutions should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection Is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:

QUESTION 42
DRAG DROP
A company is updating a Power Apps solution that contains two tables named Sen/ices and
Equipment. The company is creating a new solution to update the current solution for the following
requirements:
• The Services table must be updated to include change tracking.
• The Equipment table must be updated to include four new columns.
• The solution must update only the components that need to be added or changed.
You need to create the solution.
Which table option should you use? To answer, drag the appropriate options to the correct tables.
Each option may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.

Select and Place:

Correct Answer:
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Section:
Explanation:

QUESTION 43
DRAG DROP
A company that manufactures medical devices uses Power Apps to manage their sales and device maintenance. A Table named Devices in Microsoft Dataverse has a column named Status. The Status column must have a new
status value of Review added to the existing Choice values of Active and Inactive. The table must be added to a solution to be promoted once the change is made.
Only this change must be promoted to the test environment. The changes must not be able to be changed once promoted.

Select and Place:

Correct Answer:

Section:
Explanation:

QUESTION 44
DRAG DROP
You create a canvas app that uses data from a Microsoft SQL Server database.
You use a dataflow to move some of the data from the database to Microsoft Dataverse. Users will filter the data by using the app. You need to filter data in the dataflow and in the canvas app.
Which tools should you use? To answer, drag the appropriate tools to the correct requirements. Each tool may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view
content.
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Select and Place:

Correct Answer:

Section:
Explanation:
Box 1: Power Query
To filter data in a dataflow, you should use Power Query. Power Query is a data connection tool that is part of the Microsoft Power Platform, which allows you to connect to various data sources, transform, and load data into other applications
such as Power BI, Excel, and Dataverse. It is a functional, case-sensitive, and data-transformation language that enables you to discover, connect, combine, and refine data sources to meet your business intelligence needs.Power Query allows
you to filter data by using its built-in functions and operators. You can filter data by using the filter, sort, and group by functions, as well as by using custom formulas and conditions.You can also use the advanced editor to write complex queries
using M code, which is the underlying language used by Power Query.Reference: https://docs.microsoft.com/en-us/power-query/ https://docs.microsoft.com/en- us/power-query/transform/filter-rows-by-condition2nd

Box 2: Power Fx
To filter data in a canvas app, you should use Power Fx. Power Fx is a no-code, low-code, and code- based platform that enables you to build custom business logic and automate workflows in your Power Platform apps. It allows you to create
custom formulas and expressions in the app using a functional language, which allows you to filter data in the app.Power Fx can be used to create custom formulas and expressions in the app which can filter data in the app by using its built-in
functions and operators. You can filter data by using the filter, sort, and group by functions, as well as by using custom formulas and conditions. You can also use the advanced editor to write complex queries using Power Fx code.Reference:
https://docs.microsoft.com/en-us/power-apps/maker/canvas-apps/power-fx-formulas

QUESTION 45
DRAG DROP
A company has a model-driven app that uses Microsoft Dataverse.
Users need to add an alternate phone number when entering their account information. The users also require a list that displays the customers that do not have an alternate phone number. You need to enable the required
features.
Which features should you use? To answer, drag the appropriate features to the correct requirements. Each feature may be used once, more than once, or not at all. You may need to drag the split bar between panes or scroll
to view content.

Select and Place:
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Correct Answer:

Section:
Explanation:

QUESTION 46
HOTSPOT
A company plans to implement a voice-enabled Power Virtual Agents bot. The company has the following requirements for the bot:
• Recognize when a caller states Tennis or any variation of the word.
• Provide options when a caller states the name of a sport.
You need to configure the bot.

Hot Area:

Answer Area:
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Section:
Explanation:

QUESTION 47
DRAG DROP
A company uses a model-driven app for customer support. The company has the following requirements for the app:
• Send an email in real-time to customers when they enter their email address.
• Send an email to customers at the same time every day for cases that are open for more than 24 hours. The solution should require the least amount of customization.

Select and Place:

Correct Answer:
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Section:
Explanation:

QUESTION 48
HOTSPOT
You use Power Virtual Agents to create a bot that will answer and transfer help desk calls. You create topics that contain nodes and functions. The company has the following requirements for the bot:
• When a caller states the word issue, help, or problem, the bot must respond with the question.
"How can we help you today?"
• When the bot responds with the question, "How can we help you today?", the bot must provide the caller with the choices of hardware, software or other
• When the caller asks a question, the bot must save the response so that it can perform an action on the response. You need to configure the bot.
Which nodes or functions should you use? To answer, select the appropriate options in the answer area.

Hot Area:

Answer Area:
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Section:
Explanation:

QUESTION 49
HOTSPOT
A company plans to implement chatbots by using Power Virtual Agents.
The company has the following requirements for the bots:
• Users in the accounting department must be able to create a bot for frequently asked questions.
• The support desk users must be able to use the bot.
The users must not be able to change environment parameters in the Microsoft Power Platform environment. You need to configure the permissions for the bots.
Which actions should you implement? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:

QUESTION 50
DRAG DROP
A company plans to create a Power Virtual Agents chatbot.
The bot has the following requirements:
• Prompt for a location of the customer and the call must be routed to a support agent for the location.
• Transfer support calls at each location to a support bot that uses the Bot Framework.
You need to configure the bot.
Which components should you use? To answer, drag the appropriate components to the correct requirements. Each component may be used once, more than once, or not at all. You may need to drag the split bar between
panes or scroll to view content.
NOTE: Each correct select is worth one point.

Select and Place:

Correct Answer:
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Section:
Explanation:

QUESTION 51
HOTSPOT
You plan to create a Power Bi dataflow.
The Power BI dataflow has the following requirements:
• Be able to create a copy of the dataflow to separate Power Bl workspaces-
• Schedule the dataflow to update every day at 11:00 AW.
You need to configure the dataflow.
What should you do? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:

Section:
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Explanation:

QUESTION 52
HOTSPOT
You create a canvas app.
The app requires access to data that is stored in collections. The app must provide the following actions:
• Create a new collection variable.
• Remove table values from a collection.
You need to configure functions for the app.
Which functions should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:

Section:
Explanation:

QUESTION 53
HOTSPOT
You create a model-driven app for an automobile parts help desk.
A help desk agent uses a form to gather information about customers' automobiles in two custom tables. The names of the tables are Client and Automobile, The form must prepopulate the following information about the
customer from the client table:
• First name
• Last name
The agent must be able to type the following information about the automobile:
• Automobile make
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• Automobile model
You need to implement the form. What should you configure? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:

Section:
Explanation:

QUESTION 54
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the stated goals. Some question sets might have more than one
correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to is. As a result, these questions will not appear in the review screen.
A company uses a model-driven app
The company needs to automatically update the Status column in real time
You need to configure this feature.
Solution: Create a flow that has an Update item action.
Does the solution meet the goal?

A. Yes

B. No

Correct Answer: B
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Section:

QUESTION 55
You are using the Data import wizard to import records into the account table from a CSV file. The CSV-to-table mapping is as follows:
* The Name column represents the account name and maps to the Account Name column.
* The Parent Name column represents the holding company of the account with subsidiaries underneath.
Records that are imported into the table are only related to other records in the file.
You need to configure the import to create the relationship between records.
What should you do?

A. Map Parent Name in the file to the Parent Account column. Select Parent Account as the lookup criteria.

B. Create an alternate key on the account table by using the Account Name column. Do not map Parent Name in the file.

C. Look up the record IDs of the records in the Parent Account column. Add the record IDs as a new column in the file. Map the new column to the Parent Account column.

D. Map Parent Name in the CSV file to the Parent Account column. Select Account Name as the lookup criteria.

Correct Answer: C
Section:

QUESTION 56
HOTSPOT
A company plans to implement a model-driven app. The company will enter data through the app. The company has the following requirements:
* Users must be able to search for the data inside the app.
* Users must be able to search for the data outside the app.
You need to configure a solution for each requirement.
What should you use? To answer, select the appropriate options in the answer area.
NOTE: Each correct selection is worth one point.

Hot Area:

Answer Area:
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Section:
Explanation:

QUESTION 57
DRAG DROP
A company plans to implement Power Pages.
The company requests that you create demonstration sites based on the following requirements:
* A website that supports automated scheduling
* A website that supports event registration
* A website that can be extended by using the company's branding
In addition, custom development work must be minimized.
You need to identify the appropriate Power Pages templates to use.
Which templates should you use? To answer, drag the appropriate templates to the correct requirements. Each template may be used once, more than once, or not at all. You may need to drag the split bar between panes or
scroll to view content.
NOTE: Each correct selection is worth one point.

Select and Place:

Correct Answer:
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Section:
Explanation:
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